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Picarro Analyzer User Manual 

Thank you for purchasing a Picarro product. Your Picarro system is a quality product that 

has been designed and manufactured to provide reliable performance. 

This User Manual (UM) is an important part of your purchase as it will help familiarize 

you with the system and explain the numerous features that have been designed into 

it. Please read this manual thoroughly before using your Picarro system. 

Please contact Picarro or your authorized Picarro distributor should you have questions 

regarding specific applications or if you require additional information. 

NOTICES 

DISCLAIMER AND RESERVATION OF RIGHTS 

Picarro has prepared this manual solely for the information and use by its customers as a 

guide for the selection, installation, operation, and maintenance of the products 

described. 

EXCEPT AS PROVIDED IN THE TERMS AND CONDITIONS OF SALE FOR PICARRO 

PRODUCTS, PICARRO ASSUMES NO LIABILITY WHATSOEVER, AND PICARRO 

DISCLAIMS ANY EXPRESS OR IMPLIED WARRANTY, RELATING TO SALE OR USE 

OF PICARRO PRODUCTS, INCLUDING LIABILITY OR WARRANTIES RELATING TO 

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 

Picarro reserves the right to change or update the contents of this manual and the 

specifications of its products at any time, without notice. Picarro has endeavored to 

include information that is current and accurate as of the date of the publication or 

revision of this document, but Picarro does not guarantee that this document is error free 

or that it is accurate with regard to any particular specification. 

Picarro expressly reserves all intellectual property rights, including all intellectual property 

rights relating to any product described in this manual. This document does not grant any 

license, express or implied, by estoppel or otherwise, to any intellectual property rights of 

Picarro or any third party. 

PATENTS 

The products described in this manual are subject to Picarro patents and patents 

pending. Information about Picarro patents applicable to these products is available at 

www.picarro.com/company/patents 

TRADEMARKS 

Picarro and the Picarro logo are trademarks of Picarro, Inc. 

Windows® is a trademark of Microsoft Corporation 

Swagelok® is a trademark of Swagelok Company 

Copyright © 2020 Picarro, Inc. All rights reserved 

https://www.picarro.com/company/patents
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Contact Information 
 

General Technical Support: 

Email:               support@picarro.com  

Phone:             +1 408 962 3991 

 

European Technical Center: 

Email:               support@picarro.com 

Phone:     +31 85 888 1650 

 

Customer Service: 

Email:               orders@picarro.com 

Phone:             +1 408 962 3992 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 © 2020 Picarro, Inc. All rights reserved. 
3105 Patrick Henry Drive 

Santa Clara, California, 95054 USA 
Phone +1 408 962 3900 • Fax +1 408 962 3200 

www.picarro.com 
  

mailto:support@picarro.com
mailto:support@picarro.com
mailto:orders@picarro.com
http://www.picarro.com/


 

4   Picarro G2307 Analyzer User Manual 

 

Table of Contents 

1. INTRODUCTION TO TECHNOLOGY ......................................................................... 6 
1.1 CAVITY RING-DOWN SPECTROSCOPY (CRDS) ............................................................................................. 6 
1.2 RELATING RING-DOWN TIME TO ABSORPTION INTENSITY ......................................................................... 7 
1.3 CONVERTING ABSORPTION INTENSITY TO CONCENTRATION ................................................................... 8 
1.4 SPECTRAL PRECISION AND HIGH SENSITIVITY MEASUREMENTS ............................................................. 9 

2. CONVENTIONS ........................................................................................................ 11 

3. ACRONYMS ............................................................................................................. 12 

4. SAFETY .................................................................................................................... 13 
4.1 GENERAL SAFETY ........................................................................................................................................... 13 
4.2 LASER SAFETY ................................................................................................................................................ 14 

5. UNPACKING THE ANALYZER ................................................................................ 16 
5.1 INSPECT THE SHIPPING BOXES .................................................................................................................... 16 
5.2 UNPACK THE SHIPPING BOXES .................................................................................................................... 16 

6. ANALYZER OVERVIEW .......................................................................................... 19 
6.1 INTENDED USE ................................................................................................................................................ 19 
6.2 EXTERNAL VACUUM PUMP ............................................................................................................................ 19 
6.3 ANALYZER SPECIFICATIONS ......................................................................................................................... 20 

7. INSTALLATION ........................................................................................................ 21 
7.1 ANALYZER AND VACUUM SETUP .................................................................................................................. 22 
7.2 CONNECTING TO THE ANALYZER INLET ...................................................................................................... 24 
7.3 SETTING UP A MONITOR, KEYBOARD, AND MOUSE................................................................................... 25 

8. ANALYZER BASIC OPERATION ............................................................................ 26 
8.1 STARTUP PROCEDURE .................................................................................................................................. 26 
8.2 DESKTOP ICONS AND FOLDERS ................................................................................................................... 27 
8.3 SHUTDOWN PROCEDURE .............................................................................................................................. 29 
8.4 IN CASE OF AN ELECTRICAL POWER OUTAGE ........................................................................................... 30 

9. LIST OF GUI FUNCTIONS ....................................................................................... 31 
9.1 GUI OVERVIEW ................................................................................................................................................ 31 
9.2 SETTINGS, TOOLS, AND HELP MENUS ......................................................................................................... 31 
9.3 ALARM PANEL .................................................................................................................................................. 32 
9.4 INSTRUMENT STATUS .................................................................................................................................... 33 
9.5 DATA LOG FILENAME AND PATH ................................................................................................................... 33 
9.6 DATA WINDOW ................................................................................................................................................ 34 
9.7 STATUS LOG WINDOW ................................................................................................................................... 37 

10. FILE MANAGEMENT ............................................................................................. 38 
10.1 OVERVIEW ..................................................................................................................................................... 38 
10.2 DATA FILE ARCHIVAL AND AUTOMATIC DELETION OF OLD FILES ......................................................... 39 
10.3 SETUP TOOL .................................................................................................................................................. 40 

11. CALIBRATION........................................................................................................ 47 
11.1 SLOPE AND OFFSET ..................................................................................................................................... 47 
11.2 CALIBRATION METHODOLOGY .................................................................................................................... 47 
11.3 CALIBRATION SOFTWARE UTILITY TOOLS ................................................................................................ 50 

12. TROUBLESHOOTING ............................................................................................ 57 
12.1 POWER LED ON ANALYZER DOES NOT ILLUMINATE ............................................................................... 57 
12.2 USER INTERFACE PROGRAM DOES NOT START ...................................................................................... 57 



 

Picarro G2307 Analyzer User Manual  5 

12.3 SAMPLE PRESSURE CANNOT BE CONTROLLED TO THE APPROPRIATE VALUE FOR 
CONCENTRATION MEASUREMENTS ........................................................................................................ 58 

12.4 USER INTERFACE PROGRAM “FREEZES” AND DOES NOT UPDATE GRAPHS AS DATA ARE 
COLLECTED. ................................................................................................................................................ 58 

13. SERVICE AND MAINTENANCE ............................................................................ 59 
13.1 CONSUMABLES AND REPLACEMENT PARTS ............................................................................................ 59 
13.2 PARTICULATE FILTER REPLACEMENT ....................................................................................................... 59 
13.3 CASE FAN ASSEMBLY REPLACEMENT ....................................................................................................... 63 
13.4 CPU FAN REPLACEMENT ............................................................................................................................. 64 
13.5 REPLACING VACUUM DIAPHRAGMS AND VALVES ................................................................................... 65 
13.6 CLEANING ...................................................................................................................................................... 75 

14. TRANSPORTATION AND STORAGE ................................................................... 76 
14.1 PACKING THE ANALYZER ............................................................................................................................ 76 

15. LIMITED WARRANTY ............................................................................................ 77 

16. APPENDIX A – REMOTE DATA ACCESS ............................................................ 78 

17. APPENDIX B – THE DATA FILE VIEWER ............................................................ 81 

18. APPENDIX C – EXTERNAL VALVE SEQUENCER ............................................... 93 

19. APPENDIX D – DATA LOG PARAMETERS .......................................................... 98 
 

 

 

 

 

 

 

 



 

6   Picarro G2307 Analyzer User Manual 

1.    INTRODUCTION TO TECHNOLOGY 
 

Picarro analyzers use time-based, optical absorption spectroscopy of the 
target gases to determine concentration in a sample. They are based on 
wavelength-scanned cavity ring-down spectroscopy (WS-CRDS), a 
technology in which light travels many times through the sample, creating a 
very long effective path length for the light to interact with the target gas, 
thus enabling excellent detection sensitivity in a compact and rugged 
instrument.  

 

The Picarro analyzer is comprised of two modules: 

• The Analyzer contains the spectrometer, sample chamber, and a 
computer with a hard drive to store and analyze data. The single 
analyzer module controls the operation of the system and converts 
spectroscopic measurements into gas concentration data. 

• The External Vacuum Pump draws the sample gas through the 
instrument. 

 

1.1 Cavity Ring-Down Spectroscopy (CRDS) 

Nearly every small gas-phase molecule (e.g., CO2, H2O, H2S, NH3) and 
isotopologue (e.g., H2

18O, 13CO2, 15N14N16O) uniquely absorb specific 
wavelengths of near-infrared light. The strength of the light absorption is 
related to the concentration of a molecule in a sample and the distance that 
light travels through the sample, called the path length.  

Conventional infrared spectrometers are typically only sensitive enough to 
detect trace gases at levels in the part-per-million. Cavity Ring-Down 
Spectroscopy (CRDS), on the other hand, is one thousand to one million 
more times sensitive.  

In Picarro analyzers, light from a single-frequency laser enters a cavity 
where three mirrors reflect the laser light as seen in Figure 1. The light 
enters through the mirror closest to the laser, bounces off the angled mirror 
in the lower right corner of the cavity, travels to the hemispherical mirror at 
the top of the cavity, bounces toward the mirror in the lower left corner of 
the cavity, and then returns to the first mirror. This motion becomes a 
continuous traveling light wave, which is represented by the dark orange 
path in Figure 1. 
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Figure 1: 
Schematic of 

the Picarro 

CRDS analyzer 

cavity 

  

 

 

When the laser is on, the cavity quickly fills with laser light. A small amount 
of the laser light is transmitted through the mirror closest to the 
photodetector, which turns the incident light into a signal that is directly 
proportional to the light intensity in the cavity. 

When the photodetector signal reaches a threshold level (in a few tens of 
microseconds), the laser is turned off. The light contained within the cavity 
continues to bounce between the mirrors (about 40,000 times). Since the 
mirrors have slightly less than 100% reflectivity (99.999%), the light inside 
the cavity steadily leaks out of the cavity. The intensity of the light reaching 
the detector decreases, falling exponentially until it reaches zero. This 
decay, or "ring-down,” is measured in real time by the photodetector. 

 

1.2 Relating ring-down time to absorption intensity 

The time it takes to ring-down is inversely related to the total optical loss in 
the cavity, including the strength of molecular absorption at a given 
wavelength of light. For an empty cavity, the time it takes for the intensity to 
decrease by a given percent is determined solely by the reflectivity of the 
mirrors. A cavity containing gas that absorbs light will have a shorter ring-
down time than an empty cavity. As the light circulates in a cavity with a gas 
sample, the molecular absorption by the gas results in a decrease of the 
light intensity. 

Determining absorption intensity at a specific wavelength requires 
comparing the ring-down time of an empty cavity to the ring-down time of a 
cavity that contains gas. Picarro instruments gather measurements from an 
“empty” cavity by switching the light to wavelengths that are not absorbed 
by the target molecules. The analyzer subsequently measures ring-down 
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times at wavelengths that are absorbed by the target gas. The analyzer 
automatically and continuously compares these two types of ring-down 
times, and the software uses those comparisons to calculate absorption 
intensities. 

 

Figure 2: 
Light intensity 

as a function of 

time in a CRDS 

system 

 

1.3  Converting absorption intensity to concentration 

Plotting the absorbance at each measured wavelength generates an optical 
spectrum. This spectrum contains absorbance peaks that are unique to 
each molecule in the sample. The height of a particular absorption peak is 
proportional to the concentration of a molecule that generated the signal.  

The height of the peak is calculated by subtracting the maximal absorbance 
from the baseline absorbance. Figure 3 shows a plot of ideal optical spectra 
with a clean, uniform baseline on either side of the absorption peak. 
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Figure 3: 
Absorption 

Spectral Curve 

  

 

Optical spectra often contain several absorption lines, nested closely 
together. A particular absorption peak may be visible between lines, but the 
absorption may not return to the baseline before it rises in response to 
another molecule. Picarro analyzers calculate the baseline underneath a 
poorly resolved peak by modeling the absorption peaks from other 
surrounding molecules and subtracting contributions from neighboring 
peaks to the absorption intensity.  

 

1.4 Spectral precision and high sensitivity measurements 

 Picarro analyzers contain two features that provide high spectral 
precision:  

• A proprietary wavelength monitor (WLM) that measures the absolute 
laser wavelength to a precision that is a few orders of magnitude 
narrower than the spectral linewidth: Picarro’s patented WLM measures 
absolute laser wavelength to a precision more than 1,000 times 
narrower than the observed Doppler-broadened linewidth for small gas-
phase molecules. The instruments lock the laser to the WLM, and then 
the monitor tunes to wavelengths known to be maximally and minimally 
absorbed by the target molecule. The result is closely clustered 
absorption intensities at and around the wavelength of peak absorption.  
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• Precise temperature and pressure control in the sample cavity: 
Accurate absorption measurements at precisely known wavelengths 
account for little unless the temperature and pressure of the CRDS 
measurement cavity are known. The observed line intensity and shape 
depend on the temperature and pressure inside the sample cavity. To 
completely minimize instrument measurement drift, temperature and 
pressure must be actively stabilized to constant values.  

 

For precise temperature control, the sample cavity is surrounded by layers 
of thermally insulating material to provide a high degree of passive thermal 
stability. The cavity is further actively stabilized by means of a solid-state 
heating system locked to the output of a thermal sensor. This enables the 
temperature of the cavity to be within 20 mK of the set temperature.  

For precise pressure control, the cavity pressure is monitored using a high-
linearity pressure transducer. The system computer uses this pressure data 
in a feedback loop to control proportional valves that adjust the inlet and 
outlet gas flow of the cavity.  
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2.   CONVENTIONS 
 

The following icons are used throughout this manual to emphasize 
important information in the text. These icons indicate dangers to either the 
operator or to the analyzer, and other important information. 

 

 

Consult the user’s manual for important information 

(When you see this symbol placed at hazard points on 

equipment, consult the user manual). 

 

NOTE is important information that you should be aware 

of before proceeding. 

 
WARNING 

WARNING indicates an imminent danger to the user. 

WARNING 

LASER WARNING alerts you of a laser danger. 

 
CAUTION 

CAUTION alerts you of a potential danger to equipment 

or to the user. 

 
REMINDER 

REMINDER is a helpful hint to procedures listed in the 

text. 
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3.    ACRONYMS 
This manual includes various acronyms. For definitions, see below:  

 

Acronym Definition 

CRDS Cavity Ring-Down Spectroscopy  

GUI Graphical User Interface  

cm centimeters  

mm millimeters  

” (as in 1/4”) Inches 

CH2O Formaldehyde 

CH4 Methane 

H2O Water 

HB Hotbox  

WB Warm box  

ppm Parts Per Million  

ppb Parts Per Billion  

‰ per mil  

°C degrees Celsius  
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4.    SAFETY 

4.1 General Safety 

CDRH Certification 

This Picarro Analyzer complies with 21 CFR Chapter 1, sub-chapter J, and 
is classified as a Class 1 laser system when all panels and covers are on. 

CE Certification 

This Picarro Analyzer complies with the European standards and the 
instrument is affixed with a CE label. This CE label is located on the rear of 
the instrument. 

 

 
WARNING 

Using this analyzer in a manner not specified by Picarro may 

result in damage to the analyzer and render it unsafe to operate. 

 

 
WARNING 

This analyzer is for indoor use only and has an ingress protection 

rating of IPx-0. Analyzer is NOT protected against exposure to 

water including dripping, spraying, splashing or immersion. 

 

 
WARNING 

Do not operate in an explosive atmosphere! Do not operate in the 

presence of flammable gases or fumes.  

 

 
CAUTION 

The analyzer contains no user serviceable components except the 

particulate filter, fans, and the vacuum pump. Do not attempt 

repairs; instead, report all problems to Picarro Customer Service 

or your local distributor. Please contact Picarro if you have any 

questions regarding the safe operation of this equipment. 

 

 
WARNING 

The inlet gas connector on the back panel of the Analyzer, and its 

immediate vicinity, runs hot during operation of the analyzer. Take 

care when connecting gas lines or working at the rear of the 

instrument to wear protective gloves or avoid contact with these 

surfaces. 

 
 



 

14   Picarro G2307 Analyzer User Manual 

 

WARNING 

This analyzer weighs 47 lbs. (21.3 kg). Use the technique described 

below when lifting the analyzer. 

 

 

a. Before lifting, inspect the unit for slippery substances or sharp 

edges. 

b. Lift with two people, one on each side of the analyzer. 

c. Crouch down and stay close to the unit. Always keep your back 

as straight as possible.  

d. Position your feet for sturdy balance. Lift with your legs, not 

your back.  

e. Do not twist the back while carrying the unit. Rotate direction 

with hip joints.  

f. Lower the unit by bending at the knees. 

4.2 Laser Safety 

 
WARNING 

This equipment is classified as a Class 1 laser product with an 

embedded 3B laser in accordance with EN 60825-1:2014. Do not to 

open the enclosure where this label is placed; there are no user 

serviceable parts inside. 

 

The following Laser Safety Label is affixed to the outer cover of the 
analyzer. 

 

 

 

 
WARNING 

The laser is a Class3B when exposed.  

Only operate or service this device in accordance with the 

instructions in this guide, and only open the device in an approved 

laser safe service area using appropriate laser-safety glasses. 

 
The following Laser Safety Label is affixed to the inside of the analyzer:  
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Figure 4: 
Laser Safety 

Label 

 

 

 
WARNING 

Use of controls or adjustments or performance of procedures other 

than those specified herein may result in hazardous radiation 

exposure. 
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5.    UNPACKING THE ANALYZER 

5.1 Inspect the Shipping Boxes 

Picarro products are inspected and tested before leaving the factory. Their 
packing containers have been designed to keep the equipment safe from 
damage during transit. 

Inspect the condition of the boxes upon arrival. The larger box includes the 
analyzer and most of the accessories. Even if the outer box shows damage, 
the inner box holding the analyzer is cushioned enough that it will protect 
the instrument under most circumstances. 

If the equipment does appear to be damaged, photograph the damages and 
contact Picarro (email pictures if possible) as soon as possible. 

 

5.2 Unpack the Shipping Boxes 

This section describes the contents of the shipping boxes: 

• Inspect each item to ensure it is not damaged.  

• If items are missing, contact Picarro. 

• Keep the shipping packages to reuse when transporting the analyzer. 

• Contact Picarro for options on transporting systems to remote labs. 

 
WARNING 

This analyzer weighs 47 lbs. (21.3 kg). Use the technique outlined in the 

General Safety section on page 14 when lifting or moving the analyzer.  
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Figure 4: 
Box Contents 

 
 

Box One: Analyzer and Accessories  
 

Item (qty) Description 

Analyzer (1) Includes all the data acquisition, control, and 

communications hardware and firmware to perform 

all gas handling, spectral collection and analysis. 

A/C Power  

Cables (1) 

A power cable with connectors appropriate to your 

country is provided. The analyzer automatically 

adjusts to local voltage. 

Keyboard (1) USB keyboard 

Mouse (1) USB mouse 

Control Cable (1) For External Solenoid Valves 

Nut (1) and 

Ferrules (2) 

For connecting input line to analyzer INPUT 

Document Packet 

(1)  

Includes this manual, certificate of compliance, and 

Windows License. 

USB Flash Drive  Contains backup software. 
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Box Two: Vacuum Pump and Accessories 
 

Item (qty) Description 

Pump (1) Provides vacuum required for sample gas 

sequencing into and out of the analyzer. 

A/C Power  

Cable (1) 

A power cable with connectors appropriate to your 

country is provided.   

Vacuum Hose (1) Hose to connect the pump to the analyzer. 

Pump Manual (1) Detailed instructions for pump. 
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6.    ANALYZER OVERVIEW 

6.1 Intended Use 

The G2307 Analyzer measures concentrations of CH2O and H2O 
simultaneously and precisely using Picarro’s patented Cavity Ring-Down 
Spectroscopy (CRDS) technology. The analyzer can be deployed in a lab or 
in the field, allowing in-situ analysis for both trace and ambient amounts of 
CH2O and H2O monitoring applications.      

6.2 External Vacuum Pump 

The external vacuum pump is used to maintain cavity pressure inside the 
analyzer. The pump should be connected and running whenever the 
analyzer is in use. 

 

Figure 5: 
External 

vacuum pump  

 

 

  

Power Switch 

Vacuum Inlet 

Power Connector 
Exhaust Port 
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6.3 Analyzer Specifications 

 

Weight (Total) 

Analyzer 

Pump 

60.4 lbs. (27.4 kg), Including external pump 

47 lbs. (21.3 kg) 

14.4 lbs. (6.5 kg) 

Analyzer Dimensions Length: 17.55" (43.2 cm) 

Width: 17” (44.6 cm) 

Height: 7" (17.8 cm) 

Temperature Range Storage: –10 °C to 50 °C; Operation: 10 °C to 35 °C 

Sample Flowrate ~ 400 sccm at 760 torr (101 kPa) 

Ambient Humidity Range  < 85% R.H. non-condensing 

Maximum Altitude 10,000 ft. (operation) 

Clearance Front: 6" (15.3 cm); Rear: 6" (15.3 cm) 

Power Requirements 

Startup Power 

Steady-state Power 

Mains Supply Voltage 

Fluctuation 

100 to 240 VAC; 47 to 63 Hz (auto-sensing) 

<375 W at start-up (Analyzer and Pump) 

120 W (Analyzer), 150 W (Pump) Steady-state operation 

±10% of the nominal voltage 

Minimum Rated Circuit 

Amperage 

10 A @115 VAC 

5 A @230 VAC 

Liquid Ingress Protection None 
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7.    INSTALLATION 
This section describes the setup and installation of the Picarro Analyzer. 
Please read and understand this section thoroughly before proceeding with 
the installation. 

 

 
WARNING 

Using this analyzer in a manner not specified by Picarro may 

result in damage to the analyzer and render it unsafe to operate. 

 

 
WARNING 

Do not attach electrical power to or start the analyzer until after 

attaching and turning on the External Vacuum Pump. Do not 

disconnect the vacuum line while the analyzer is running. Failure 

to do so could result in damage to the optics. 

 

 
WARNING 

Picarro sells USB enabled devices, such as GPS, which is 

approved for use. Please do not connect USB hubs or unapproved 

USB devices, other than flash drives to the computer because 

they can interfere with the operation of the analyzer. 

 

 
WARNING 

If rack mounted, the Analyzer cannot support itself using a front 

rack mount kit alone. The instrument must be supported by a 

shelf or additional rails attached to the rack. 

 

 
CAUTION 

If the analyzer has been stored at less than 10 °C, allow the 

components to equalize to room temperature before starting the 

installation process.   

 

 

CAUTION 

Analyzer is for indoor use only and has an ingress protection 

rating of IPx0. Analyzer is NOT protected against exposure to 

water including, but not limited to, dripping, spraying, splashing 

or immersion.  
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CAUTION 

When the analyzer is being integrated to an external system, the 

safety of that system is the responsibility of the assembler of that 

system.  

 

 

CAUTION 

During installation and operation, do not position the analyzer so 

that it is difficult to operate the disconnecting device.  

 

 
NOTE 

Take care to ensure that warm air is exhausted from an enclosure 

in which the analyzer is mounted. 

 

 
CAUTION 

It is imperative that the analyzer have adequate ventilation and/or 

cooling to maintain the ambient temperature below 35 °C when 

operating. Failure to provide adequate airflow, especially 

clearance at the front and rear panels, to ensure proper airflow 

and/or cooling to the analyzer will result in overheating of the 

analyzer causing a shutdown and potential damage. There 

should be 4” (10cm) of clearance in the front and back of the 

analyzer. 

 

Thermal 

Specifications 

Min Max Description 

Ambient Operating 

Temperature 

10 C 35 C Worst-case environmental 

limits (unless otherwise 

specified) 

 

7.1 Analyzer and Vacuum Setup 

1. Remove the Analyzer and the External Vacuum Pump from their 
respective shipping containers. 

 
WARNING 

This analyzer weighs 47 lbs. (21.3 kg). Use the technique outlined in the 

General Safety section on page 14 when lifting or moving the analyzer.  
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2. Place the Analyzer on a bench top or flat surface. Place the External 
Vacuum Pump near-by or on the floor. Don’t push the analyzer into 
position yet, there are cables to be installed on the back panel. 

3. Unpack the analyzer accessories. The Certificate of Compliance and 
USB drive should be stored in a safe place and may be required if 
you contact Picarro with questions about your analyzer. 

4. Remove the caps from the analyzer’s INLET and VACUUM 
connection ports. Save the caps; you should reinstall them when the 
analyzer is stored, moved or shipped. 

5. Remove the cap from vacuum pump’s inlet. Save the cap for later 
use. Reinstall the caps when the pump is stored, moved or shipped.  

6. Connect one end of the vacuum hose to the pump: hand tighten the 
nut and then use an 11/16" wrench (not included) to make an 
additional turn of one flat (about 60 degrees).  

7. Connect the analyzer to a power source using the supplied AC 
power cable.  

 
CAUTION 

Use the AC power cables supplied with the analyzer or a similarly rated 

cable. Check with Picarro technical support if you have questions 

about power cable replacement. An inadequately rated power cable can 

result in equipment damage. 

 

 
CAUTION 

Cords shall be rated for the maximum current for the equipment and 

the cable used shall meet the requirements of IEC 60227 or IEC 60245. 

Cords certified or approved by a recognized testing authority are 

regarded as meeting this requirement. The connector type used should 

be: IEC320 C13. 

8. If desired, attach a tube to the External Vacuum Pump exhaust port 
and direct to a safe place for venting the mixture of sample gases. 

9. Select the appropriate voltage, 110V or 220V, for the External 
Vacuum Pump using the Power Switch located on the pump. 

10. Connect the External Vacuum Pump to a power source using the 
other AC power cable. 
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Figure 6: 
Analyzer Back 

Panel  

 

 

 
NOTE 

The software to operate the instrument will start automatically after the 

operating system has loaded. The user interface will appear a few seconds 

after the instrument software starts. See “Startup Procedure” on Page 26 

7.2 Connecting to the Analyzer Inlet 

Connect to the inlet of the analyzer using ¼" OD PTFE or PFA tubing using 
the supplied plastic ¼" PFA inlet nut and ferrules. 

 
WARNING 

When using compressed gases, follow all appropriate safety conventions, 

including use of eye protection, physical restraint of cylinders, etc. 

Making a new connection: 

When using new tubing, follow these steps. 

1. Place the two ferrules inside the nut as shown. 

Figure 7: 
Orientation of 

ferrules and nut  

 

2. Loosely connect the nut to the INLET on the back panel of the analyzer 
about a full turn, being careful not to let the ferrules fall out. 

3. Insert the tubing into the back of the nut, feeding it in as far as possible 
without deforming the tubing. 
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4. Hand tighten the nut. 

5. Using a 5/8" wrench (not included), tighten the nut approximately seven 
flats (420 degrees). 

Replacing a connection  

When reattaching tubing that already has a nut connected: 

1. Inspect ferrules. If you see any damage, replace the ferrules and follow 
the directions above for making a new connection. 

2. If there is no damage, hand tighten the connector to the analyzer’s 
INLET. 

3. Using a 5/8" wrench (not included), tighten the nut approximately one 
flat (60 degrees).  

7.3 Setting Up a Monitor, Keyboard, and Mouse 

A video monitor (not included), keyboard, and mouse are required for 
monitoring device operations, viewing or changing settings (including 
setting user permissions), or validating device performance. 

 

 
NOTE 

This device will operate under its default settings without any direct 

control of the internal software. 

 

1. Connect a keyboard to one of the available USB ports. 

2. Connect a mouse to one of the available USB ports. 

3. Connect a monitor to one of the DVI monitor ports. The analyzer will 
detect the connection and adjust the resolution to match the monitor. 

4. Connect the monitor to a power source. 

5. Turn on power to the monitor. 
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8.    ANALYZER BASIC OPERATION 

8.1 Startup Procedure  

This section describes the steps to power on the system. These steps are 
sufficient for operating the instrument. 

 
CAUTION 

Always turn on the external pump before turning on the analyzer.  

1. Switch on the external vacuum pump.  

2. Switch on the main power to the analyzer.  

3. Press the soft power button located on the front panel. The software 
will start automatically, and the analyzer will display the CRDS Data 
Viewer window. Data Viewer features are detailed in Section 9.  

4. Wait approximately 45 minutes for the system to power, initialize, 
and stabilize. 

5. Once the cavity pressure and operating temperature are at their 
proper setpoints and stable, the analyzer will start measuring. 

 
NOTE 

As the instrument is starting up, it is normal for there to be a delay in 

reporting data. This can take several minutes depending on how long it 

takes for the internal temperature and pressure to reach their operating 

points, and it is normal during this time for some concentration 

readings to be negative or constant. The pull-down menus in the Data 

Viewer will not be populated until actual data is being reported. This is 

typically within less than 30 minutes from startup but can take up to 1 

hour to stabilize depending on ambient temperature. 

 

 
NOTE 

Throughout this manual, some of the GUI screenshots may be generic 

and/or not specific to the actual gas being analyzed. These figures are 

examples of universal analyzer functions and are used for training 

purposes.      
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Figure 8: 
Picarro 

Analyzer GUI 

 

8.2 Desktop Icons and Folders 

On the Windows™ desktop, there will be the following icons and folders: 

1. Start Instrument: When clicked, the analyzer will start measuring in 
the configuration that it was in when the software/analyzer was shut 
down. 

2. Coordinator Launcher: Depending on the system’s configuration, 
the coordinator program may not be included. Clicking on this icon 
will lead you to a window that will allow you to choose the proper 
coordinator to operate the peripheral module that came with your 
analyzer.   

3. Picarro Mode Switcher: When clicked, you will be led to a window 
that will allow you to switch between various measurement modes. 
Most analyzer models are configured for one mode and may not 
include the Mode Switcher. If the analyzer has multiple modes, this 
allows the user to switch between them easily. 

4. Picarro Controller: When clicked, you will be led to a useful 
diagnostic panel allowing the user to see the analyzer’s internal 
temperatures, pressure, and spectroscopy in real time. This program 
has user-accessible functions, but it cannot change anything related 
to analyzer functionality. It is intended for diagnostic purposes only. 

5. Picarro Utilities Folders:  

i. Data file Viewer: When clicked, you will be led to a window 
that will allow you to convert between *.dat and H5 data files 
and to make various graphical representations of your data. 
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The instructions on using the Data File Viewer software are 
described in Appendix B on this manual.  

ii. Data Recal: When clicked, you will be led to a window that 
will allow you to recalibrate your data based on known, 
certified data. 

iii. Setup Tools: When clicked, you will be led to a window that 
will allow you to edit various settings for your analyzer (See 
the Setup Tools section of this manual for information about 
these settings). 

6. Diagnostic Folder 

i. Stop Instrument: When clicked, you will be led to a window 
that will allow you to turn off the analyzer in an emergency 
event. Upon clicking on this icon, the following window will 
pop up. Please see Shutdown Procedure on page 29 of this 
manual to shut down the analyzer in normal circumstances. 

Figure 9: 
Stop CRDS 

Software  

 

 

 
CAUTION 

EXCEEDING GAS INLET PRESSURE OR TEMPERATURE SPECIFICATIONS 

COULD RESULT IN DAMAGE TO THE INSTRUMENT. In the case of higher 

input pressure or flow, configuring a sampling bypass manifold system is 

recommended. 

Use a ‘tee’ at the gas inlet and either return the remainder to the main gas 

stream or exhaust appropriately. 

 

 
CAUTION 

Do not disconnect the AC power to the analyzer, vacuum line or the AC 

power to the External Vacuum Pump while analyzer is operating. Damage 

may be caused by current surges if power is applied while attaching or 

removing cables. 
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8.3 Shutdown Procedure 

To shut down the analyzer using the GUI:   

1. Click on the “Shutdown” button located on the left side of the Data 
Viewer window.   

2. A window will pop-up prompting the user to confirm the shutdown. 
Once confirmed, the analyzer software and hardware will begin 
shutting down.    

3. Once the hardware has completed shutdown, manually turn off the 
pump(s) and dry gas (only if your system requires it). 

Figure 10: 
Shutdown 

Window  

 

 

 
CAUTION 

A flow of clean, dry gas should always be directed to the instrument for 

several minutes prior to shutting down. Trapping a high-moisture content gas 

sample in the cavity can cause condensation damage to the mirrors as the 

instrument cools from its operating temperature. 

 

 
CAUTION 

Do not turn off the pump or disconnect the vacuum line while the instrument 

is operating. 

 

Shutdown button 
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CAUTION 

FOR G2000 ANALYZERS: If you have trouble turning off the analyzer 

software, do not kill the process(es) in the task manager; rather, double-click 

on the "Stop Instrument" icon in the Diagnostics folder on your desktop. 

8.4 In case of an Electrical Power Outage 

If the power to the analyzer is cut-off for any reason, the analyzer will cease 
operation. However, when the power is reapplied, the analyzer will restart 
automatically. The Picarro software tools will also properly close out 
previous files and open new files for data collection so that previously 
collected data, instrument diagnostics, and other parameters recorded up to 
the time of power outage are retained. 

If short power outages will be a routine occurrence in your operating 
environment, Picarro recommends the use of an uninterrupted power 
supply to prevent damaging the hardware or software.  
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9.    LIST OF GUI FUNCTIONS 

9.1 GUI Overview 

The features of the Picarro analyzer GUI are identified in Figure 11 and 
described in the following sections.  

Figure 11: 
Layout of the 
Analyzer GUI 

The heading may 
vary depending 
on the analyzer 

model.  

 

9.2 Settings, Tools, and Help Menus 

Settings Menu  

Left clicking on the Settings menu pulls down a menu that has one entry 
‘Change GUI Mode from Standard to Service.’ This is the access point to a 
password protected service mode where additional operational and 
measurement parameters are displayed. Selecting and clicking on this entry 
opens the Cavity Ring-Down Spectrometer Controller. This is reserved for 
Picarro service operators only. 
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View Menu 

This menu item has three entries: 

1. Lock/Unlock time axis when zoomed: When locked, forces the two 
graphs to display the same time scale during zoom. 

2. Show/hide statistics: Toggles the measurement statistics display, see 
Digital Readouts below. 

3. Show/hide instrument status: Toggles the status of the instrument 
display. See 

4. Instrument Status below. 

Tools Menu 

This menu item has three entries: 

1. User Calibration: Opens the user calibration window (default 
password is “picarro”). The password can be reset in the QuickGui.ini 
file in the instrument directory C:\Picarro\G2000\AppConfig 
\Config\QuickGUI\ under the section 
[Authorization] UserCalPassword = Picarro Show/Hide Valve 

2. Sequencer GUI: Toggles the display of the external valve sequencer 
window. 

3. The calibration slope and intercept can be entered, and their effects 
immediately were seen in the data. Please refer to the Calibration 
Section on page 47. 

Help Menu 

1. About: Displays the version number of the instrument. 

9.3 Alarm Panel 

This panel is used to monitor the status of the internal instrument alarms. 
These indicators are gas concentration alarms, such as “CH2O Too 
High/Low” depending on instrument configuration. The gas concentration 
alarm LEDs are off (grayed) when the respective concentrations are below 
a certain value, and they are illuminated when the respective concentrations 
are above/below a certain value. To view the alarm set point, click on the 
LED and a dialog box will appear indicating the alarm setting and allow the 
user to enable it or change the setpoint: 
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Figure 12: 
Alarm Setting 

Window  

 

Type the value you wish to set the alarm to and press the “OK” button, or 
press “Cancel” if you do not wish to change the alarm value. If you do 
nothing, the dialog box will disappear, and the alarm value will remain 
unchanged. 

9.4 Instrument status 

If these parameters are enabled through the ‘Show Instrument Status’ entry 
in the ‘View’ Menu on the main toolbar digital readouts for Warm Box 
temperature, Cavity Temperature and Cavity Pressure are displayed to the 
left of the main trend graphs. 

 

Figure 13: 
Instrument 

Status  

 

9.5 Data Log Filename and Path 

The filename and path of the active data log are displayed in this pan. The 
indicator is grayed-out if there is no active data log (i.e., if a new data log 
has not been started using the Start /Stop New Data Log Button). A new file 
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will be generated at midnight, which will be saved to the same location as 
the original log file. 

Figure 14: 
Data Log 
Filename  

 

9.6 Data Window 

The data window displays a graph of any stream of data vs. system time, 
with a format of hh: mm: ss. The user can select which data stream is 
displayed using combinations from the Data Source and Data Key pull-
down menus. The precision displayed can be adjusted using the “Precision” 
menu and Auto-scaling of the ‘Y’ axis is also available. 

Figure 15: 
Data  

Window  

 

Data Source and Data Key Pull Down Menus 

These two menus enable selection of the data stream that is viewed in the 
data window. Data streams available on the GUI are gas concentrations, if 
‘instrument Analysis’ (where instrument represents the system installed) is 
selected, or if “sensors” is selected, the analyzer’s optical cavity pressure or 
temperature can be viewed as well as the nominal ambient temperature of 
the analyzer (“DAS temp”) and the temperature of the analyzer’s electronics 
chamber, indicated as “warm chamber temp.” 
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Figure 16: 
Data  

Source  

 

Precision Pulldown Menu 

Click on this icon to select the precision displayed on the y-axis, between 0 
and 4 digits of precision or “auto.” The currently selected precision is 
displayed during operation. This does not affect the precision of the saved 
data in the data log files or results files. 

Figure 17: 
Precision 
Pulldown  

 

Data Buffer Level Meter 

The meter to the right of the Data Window indicates how much of the 
internal memory of the GUI is used to retain historical data collected with 
the instrument. There is an internal limit of a finite number of points. Once 
that number of data points is collected, the buffer is full, and old data is 
removed from the buffer as new data is collected. This buffer affects only 
the data displayed in the data window, not the data stored in any files. This 
buffer is empty upon instrument startup and can also be emptied by 
pressing the reset data buffer button in the lower-right-hand corner of the 
GUI. 

Figure 18: 
Data Buffer and 

Reset Buffer  
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Reset Data Buffer Button 

Press this button to clear the internal data buffer of the GUI (this clears the 
current data traces from the graphs). This has the effect of clearing all data 
in the data window. Pressing this button has no effect on any of the data log 
files stored by the instrument. 

Graph Zooming 

To zoom the graph, simply drag the magnifying glass over the section to be 
zoomed and click and hold the left mouse button. While holding down the 
left button, move the mouse to create a box that covers the region of 
interest. When the box is properly drawn, release the left button and boxed 
area will automatically scale to fill the data window. To zoom back out, 
double-click on the left button. To auto scale, the y-axis of either graph, use 
the auto-scale buttons below the graph. To lock or unlock the time axis of 
each graph during zooming, select that menu item in the ‘View’ menu. 

Figure 19: 
Graph  

Zooming  

 

Digital Readouts 

Displays the latest value recorded for the selected Data Key for each Data 
Window. Changing the Data Key modifies the Digital Readout as well as the 
Data Window view. If the ‘Show Statistics’ entry is enabled in the ‘View’ 
menu, the mean, standard deviation and slope of the data in the graph are 
dynamically calculated and indicated below the digital concentration 
readout. These numbers change to reflect statistics of whatever data is in 
the data window. 

Figure 20: 
Digital  

Readout  
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Start / Stop Data Log Button 

The Analyzer automatically records all data collected on the instrument and 
saves it for later analysis. These files are called Data.dat files, which are 
described below in the section called File Management. In addition, the 
user can record a separate data log file. Press this button if you would like 
the instrument to start recording a separate data file. A dialog box will 
appear prompting you for a filename and location. Press this button again to 
stop recording the data file. 

9.7 Status Log Window 

This window displays instrument status messages, in the following form: 
“MM/DD/YYYY hh: mm: ss generic message text.” These messages include 
all messages sent to the DAS front panel display. The common status log 
messages are: 

1. Temperature Locked: WB (HB) 

The system waits for the warm box (“WB” – the temperature-controlled 
electronics and wavelength monitor chamber) to reach operating 
temperature. Similarly, the temperature of the hot box (“HB” – the 
temperature-controlled chamber containing the analyzer’s optical cavity and 
gas handling system) is stabilized. This is typically the longest step in the 
startup sequence. The duration of this step can range from 5 to 60 minutes, 
depending on the ambient temperature and how much time has elapsed 
since the last startup. 

2. Entering Measurement  

Spectral scanning has started. Concentration measurements will be 
available in approximately 30 seconds. The instrument will continue to scan 
and report concentration measurements until the instrument is shut down 
using the procedure below. 

3. Pressure Stabilizing/Locked 

The valve control system begins to allow flow through the analyzer and 
stabilizes the pressure inside the cavity. 

4. Measuring  

This is the normal mode of operation after startup has completed. 
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10. FILE MANAGEMENT 

10.1 Overview  

During operation, the Analyzer generates various ASCII-format text output 
files that are updated after each batch of concentration measurements 
is complete. For example, one of the user's output files is named 
CKFBDS##-YYYY-MM-DD-hmm- DataLog_User_Sync.dat where 
“CKFBDS##” or similar is the instrument serial number. The data files are 
created every 60 minutes. 

The file name is generated from the instrument serial number, the date, 
and the time when the instrument was started. For example: 

CKFBDS01-20070127-1029-DataLog_User.dat 

CKFBDS01 is the instrument serial number 

20070127 is the date, 1/27/2007, in format YYYY-MM-DD (to allow 
chronological sorting of data files). 

1029 is the time the file was started, 10:29 am, formatted as hhmm using a 
24-hour clock. 

Raw Data 

The   raw   user   data   is   contained   in   folders   in   the   directory:   
C:\UserData\DataLog_User\[year]\[month]\[day]\hour. This is data that has 
not been re-sampled to exact 0.1s time intervals. There is a similar 
directory (C:\UserData\DataLog_Sync\...) which includes data that is evenly 
spaced in time at the data rate of the analyzer. 

File Deletion 

File deletion frequency and details can be modified in the file: 
C:\Picarro\G2000\AppConfig\Config\Archiver\Archiver.ini 

Data Directories  

During data acquisition, the analyzer creates directories to store the data, 
based on the date the data were acquired. After each data file has been 
closed it is moved to an archive directory, and a new file is started in the 
original location. The archive directory is C:\Picarro\G2000\Log\Archive\ 
and has subdirectories DataLog_Mailbox, DataLog_Private and 
DataLog_EventLogs with files arranged by year\month\day\hour. 

There are complete data files which include additional information beyond 
the concentration data including parameters such as instrument 
temperatures and pressure, set points and spectroscopic information. This 
information is generally not useful to the user, but can be useful for 
diagnostic purposes and is stored in the following directory: 
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C:\Picarro\G2000\Log\Archive\DataLog_Private \[year]\[month]\[day]\[hour] 

Current Data File 

The current data file can be found in C:\Picarro\G2000\Log\DataLogger\. 
Within this directory, there are subdirectories for DataLog_Private, 
DataLog_User, and DataLog_User_Sync. Similarly, the archive directory 
has subdirectories arranged by file type. The subdirectories are further 
organized by \[year]\[month]\[day]\[hour]. 

To keep the data files easy to manage and to limit the size of individual 
files and directories, the software automatically generates new files each 
time the instrument is powered up and at midnight each night. When new 
files are created at midnight, their file name will contain the new date and a 
time of 00:00. For example, if the system was started at 10:29 am on    
2/5/2007, it would create a file named: 

20070205\CKFBDS01-20070205-1029-UserLog.dat  

Then at midnight, a new file will be created:  

CKFBDS01-20070206-0000-UserLog.dat 

10.2 Data File Archival and Automatic Deletion of Old Files 

The analyzer can automatically compress (zip) and archive old files. 
This operation is controlled by the initialization file:  

C:\Picarro\G2000\ AppConfig\Config\Archiver\Archiver.ini 

For each file type, there are various items along with some recommended 
default settings which may vary by file type: 

• Directory = C:/UserData/DataLog_Sync 
Optionally specifies which directory to find files to the archive. 

• MaxCount = -1 
Specifies how many files to keep. A setting of -1 indicates that there 
is no maximum number of files. Generally, -1 is used in conjunction 
with a maximum size limit, below. 

• MaxSize_MB = 1500 
Specifies that a maximum of 1.5 GB of data is to be kept before the 
system begins to delete old data. 

• Compress = True/False 
Specifies if archived files are to be zipped – recommended setting is 
true to save hard drive space. True means files are zipped, false 
means files are not zipped. 

• AggregationCount = 0 
If compression is set to TRUE, specifies how many files to be 
included in each zip archive. 
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• StorageMode = FIFO 
“First in first out.” Specifies that old data is deleted first. 

• Quantum = 4 
Generally, should not be changed. Specifies the files be sorted by 
year\month\day\hour in the archived directory structure. 

In addition to the automatic file and directory management described 
above, the analyzer also automatically deletes various files specified in the 
initialization file: 

C:\Picarro\ G2000\AppConfig\Config\FileEraser\FileEraser.ini  

There file contains the following settings: 

• runtime_interval_hrs = 0.5 
Specifies how often (in hours) to run the file eraser. 

• path = ../../../Log/Archive/DataLog_Private 
Specifies which directory to look in for files to delete. 

• extension = data 
Specifies which files having what extension are to be deleted. If 
empty, it deletes all files. 

• delete_time_hrs = 48 
Specifies how long to keep files prior to deletion. 

10.3 Setup Tool 

In the desktop folder called Picarro Utilities, the Setup Tool can be 
launched by double-clicking on its icon. The tool allows the user to 
configure data file saving details, including which data elements are written 
to data files, digital data output (via serial port or TCP/IP), remote data 
delivery (via email), and general GUI properties. 

Serial Communication 

Picarro analyzers support an RS-232 physical command interface, which 
can be used to control the instrument and to retrieve concentration data.  
Not all features of the analyzer are available on the serial interface.  For 
details on how to use the serial command interface, please see the Picarro 
Analyzer Programming Guide (included in pdf format on the installation 
CD). This command set may also be used across a TCP/IP interface 
through an Ethernet connection. 

Configuring Data File Saving Details 

The Data Logger tab allows the user to configure various data file saving 
details, including which data elements are written to data files.   



 

Picarro G2307 Analyzer User Manual  41 

• Data Columns: Controls which data elements are written to data 
files.  

• Hours of Each Log File: Controls the size of each data document.  

• Enable Mailbox Archiving: Enables archiving of data in the mailbox 
folder: C:\Picarro\G2000\Log\Archive\DataLog_Mailbox 

• Archived Directory Structure: Specifies part of naming convention 
for data documents.  

• Total User Log Storage Size (GB): Specifies the size of storage 
allowed for User Data (Recent Data).  

After making the appropriate edits, click “Apply” to put changes into effect 
and then “Exit” to close the window. 

 

Figure 21: 
Data Logger 

Setup Window 

 

Serial/Socket Port Manager 

The Port Manager tab allows you to control digital data output/Input via 
serial port or TCP/IP. 

• Data Streaming: specify the port for data streaming 
(COM1/COM2/Off) 

• Valve Sequencer MPV: specify the port for connecting to Valve 
Sequencer (COM1/COM2/Off) 

• Command Interface: specify the port for Command Interface 
(COM1/COM2/ TCP/Off).  
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Make sure there are no COM port conflicts before clicking “Apply.” After 
making the appropriate edits, click “Apply” to put changes into effect and 
then “Exit” to close the window. 

Figure 22: 
Serial/Socket 

Port Setup 
Window 

 

Data Delivery Setup 

The Data Delivery tab allows the user to schedule remote data delivery via 
email. 

• Delivery Start Time: Time of the day when data will be sent.   

• SSL: Depending on the sender’s email server, the sender can 
activate the Secure Sockets Layer (SSL).  

• Use Authentication: Turning this on will require the receiver to 
provide a password and a username to access data. Set up the 
password and Username from this window. 

• From: Sender’s email 

• To: Receiver’s email.   

• Subject: subject line of the email.  

• Data Directory: Location of the data you want email.   

After making the appropriate edits, click “Apply” to put changes into effect 
and then “Exit” to close the window. 
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Figure 23: 
Data Delivery 

Setup Window 

 

Editing Main GUI Properties 

The GUI Properties tab allows you to set the number of line graphs visible 
on the main GUI.   

In this tab, you can enable control of a connected Valve Sequencer from the 
main GUI: 

1. Click on “Settings” of the “Setup Tool” window, and then “Switch to 
Service” mode.  

2. Choose “Yes” next to “Enable Control Valve Sequencer” drop down 
menu on the “GUI Properties” tab.  

3. Click “Apply” to put changes into effect and then “Exit” to close the 
window. 

You should now be able to access the “Show/Hide Valve Sequencer GUI” 
menu from the main GUI under “Tools” 
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Figure 24: 
GUI Properties 

Window 

 

Specifying Digital Data Output for Command Interface 

The Command Interface tab allows you to specify the data elements that 
are sent via COM port/TCP (specified in the Port Manager tab). Two types 
of data can be specified here: Datalog_User and DataLog_User_Sync.  

After making the appropriate edits, click “Apply” to put changes into effect 
and then “Exit” to close the window. 

Specifying Digital Data Output for Data Streaming 

The Data Streaming tab allows you to specify the data elements that you 
want to send via COM port (specified in the Port Manager tab). Two types 
of data can be specified here: Datalog_User and DataLog_User_Sync.  

Data Streaming outputs data continuously, whereas the Command Interface 
needs commands to prompt data output. 

 After making the appropriate edits, click “Apply” to put changes into effect 
and then “Exit” to close the window. 
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Figure 25: 
Command 

Interface 
Window 

 

 

Figure 26: 
Data  

Streaming 
Window 
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Customizing Analog Output Channels (if applicable) 

The Picarro analyzer may be optionally configured with an Electrical 
Interface Card (EIC) that provides up to 8 analog signals available to the 
user for monitoring various measurements results and analyzer parameters. 

The Electrical Interface tab allows you to customize each analog output 
channel. This tab will be disabled if your analyzer was not configured to 
work with an analog peripheral. 

After making the appropriate edits, click “Apply” to put changes into effect 
and then “Exit” to close the window. 

 

Figure 27: 
Electrical 
Interface 
Window 
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11. CALIBRATION 
Periodic recalibration with standards of known concentration maintains the 
accuracy of these quantities. Using the Data Recal Software Utility (See 
Calibration Software Utility Tools on page 50) enables the calibration 
constants to be tracked over time, thus enabling the user to follow system 
performance. 

11.1 Slope and Offset 

Every Picarro analyzer ships with a default user calibration value of 1 for 
slope and 0 for offset. While new user calibrations will likely result in 
changes to both, we recommend that only offset changes are applied during 
more frequent calibrations. 

If a new slope calibration is to be applied, the user must be mindful of their 
experimental uncertainty. For example, a change in the slope calibration 
from 1 to 0.95 may not represent a change in the system’s linearity but may 
simply reflect the experimental uncertainty. If during your slope calibration, a 
new value of 0.9 or 0.85 is suggested by the Data Recal tool, please repeat 
the measurements of your standards. In most cases, such large changes in 
slope are a result of uncertainty and do not indicate a bad nonlinearity of the 
analyzer. If your analyzer continues to suggest a large change in slope, 
please consults with Picarro Support before applying a new calibration. 

 
NOTE 

If you are uncertain about the state of your current slope and offset 

values, they can be reset back to their user default values of 1 and 0, 

respectively. In your Picarro GUI, navigate to “Tools -> User Calibration -

> (password: picarro) ->” Then change the slope and offset values of 

your parameter of interest to 1 and 0, respectively. 

11.2 Calibration Methodology 

To perform a calibration or verification of calibration, the user introduces a 
calibration standard or surrogate gas into the analyzer for a period long 
enough for the analyzer to yield a stable measurement of that sample. 

 

NOTE 

If necessary, contact Picarro for further calibration guidance and 

reference materials. Please see page 3 for Contact Information. 

Calibration Setup 

This section describes the connections from the analyzer to the gas tank. 
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• The pressure regulator at the outlet of the gas tank protects the 
analyzer from over-pressurizing. The pressure should be set to about 
1 - 3 psi. 

 

NOTE 

Users calibrating from a formaldehyde standard directly should use a 

regulator with appropriate treatments, thread, and delivery pressure. 

Picarro recommends the Airgas Y12HG445AA350-AG, which comes 

with a CGA 350 thread and internal passivated surfaces (SilcoNert® 

2000 and Kel-F® (PCTFE) or Teflon® (PTFE) seals), and a 0 to 10 psig 

delivery range.  

Users validating with CH4 tanks should use a Q1-14B-590 Air Liquide 

regulator or equivalent. The Q1-14B provides a 0 to 10 psig delivery 

range and has low internal volume to minimize memory effects and 

calibration standard loss during regulator purge procedures. 

• The toggle valve allows rapid shutoff of the gas delivery. 

• Tubing is connected to the male quick-disconnect connector 
provided with the analyzer. 

• The male connector is inserted into the inlet port of the analyzer. 

To replace the gas tank:  

1. Turn off the main valve on the gas tank. 

2. Disconnect the pressure regulator assembly from the tank. 

3. Connect the pressure regulator assembly to the next gas tank. 

Measurement Time for Each Standard 

The measurement period for a calibration standard is dependent upon the 
recorded precision of the standard gas and performance characteristics of 
the analyzer, using the Allan standard deviation plot.   

Measuring Multiple Gas Standards 

When measuring multiple gas standards, the order of the gas standard is 
not important. However, make sure that you measure the gas standard 
slightly longer than the time you determined in the previous section because 
the usable/effective data set will be trimmed down. 

Calibration Data Processing 

1. Process the calibration results from the .dat file (see File 
Management on page 38) and calculate the average recorded value 
for each standard. 

2. Plot these values versus the certified values from the gas supplier 
and determine the linear relationship between the known calibration 
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values and the analyzer’s reported values. A linear best-fit equation 
can be calculated from the data. 

.  
NOTE 

It is important to plot the analyzer’s reported concentration on the 

horizontal axis and the gas standards’ stated concentrations on 

the vertical axis. 

The slope and intercept of the best-fit line through these points are the two 
values that are used to calibrate the analyzer. By determining the linear 
relationship between the known calibration values and the analyzer’s 
reported concentration values in this way, a calibration offset (slope and 
intercept) can be calculated to add a correction term to the analyzer’s 
factory or previous calibration. 

Entering the Calibration Setting 

Changing the analyzer’s calibration is intended to be done infrequently. 
Instead of recalibrating frequently to increase the accuracy of the data, 
users often just verify the calibration by measuring three or more gas 
standards and use the same regression procedure described here to 
calculate an offset by which to correct their data offline. Using the following 
equation in the graph below, this calculation would be accomplished point-
by-point by calculating the corrected data “y” using the analyzer’s data “x” 
so that: 

Data corrected = 0.9866•Dataraw+5.268 

Figure 28: 
Linear 

Calibration 
Example 

 

Calibration values are input into the analyzer by selecting Tools > User 
Calibration, and then entering the slope and intercept for each species. 
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NOTE 

User Calibration is a password-protected form, and the default 

password is “picarro”. This password can be reset in the 

QuickGui.ini file as previously described.  

The calibration will take effect immediately after clicking OK. To return to 
the factory calibration, simply set the slope to 1 and the intercept to 0 for 
each species.   

11.3 Calibration Software Utility Tools 

Data Recal  

The Data Recal software utility is designed to enable users to perform a 
routine concentrate calibration or calibration verification of Picarro’s gas 
concentration Analyzer via a user-friendly interface. 

Data Recal allows the input of ten calibration points. Some of these points 
can be used for recalibration, while the remaining points can be used as 
quality control calibrants. In an ideal situation, three concentration certified 
standards should be analyzed on the system to generate CRDS-reported 
values for concentration. The standards with isotopic values spanning and 
encompassing the intended sample analysis should then be used to build a 
standard calibration curve. Parameters of this curve will then be used to 
correct the instrument readings so that they match standard values. The 
other standards will be simultaneously used for quality control, to verify 
other recalibrated delta values against their certified delta values. 

Data Recal GUI 

The Picarro Data Recalibration (“Data Recal”) software can be found in the 
“Picarro Utilities” folder on the desktop. The Data Recal software utility can 
be launched by double-clicking on the Data Recal Icon in the folder. Shown 
below is a screenshot of the window that will open. 
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Figure 29: 
Data Recal 

Software Utility 
GUI  

 

The Delta Recal Software Utility comprises three sections: 

1. Numerical input and selection: 

Certified and CRDS reported values are entered in the white boxes. 
Standards that will be used for instrument recalibration are then selected by 
checking the corresponding box in the first column, labeled “Used for 
Recal.” 
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Figure 30: 
Recalibration 

section of Data 
Recal Software 

Utility GUI  

 

2. Calibration output: 

In the “Calibration Options” drop-down menu, you can select either an 
“offset” or an “offset + slope.” Once the new calibration parameters are 
calculated, the Data GUI will display the new values under the “New 
Calibration” column. The parameters that appear here will depend on your 
initial selection. When the Offset + Slope option is selected, the program 

also calculates a goodness-of-fit correlation coefficient (R2). 

 

Figure 31: 
Calibration 

output section 
of Data Recal 

Software Utility 
GUI  

3. Action selection: 

In this section, the user can click on the compute button to calculate the 
new calibration parameter(s). The compute button will be grayed out until 
values have been entered in the Certified and CRDS reported columns, 
and at least one pair of Certified and CRDS reported values selected for 
the calibration. Once these values are entered or selected, the “Compute” 
button will be active. Click “Compute” to calculate the new calibration 
parameters. These parameters will appear in the Calibration output section 
of the GUI, and an asterisk “*” will be displayed at the end of the window 
title line, indicating the new change. 
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Figure 32: 
Action selection 

section of the 
Data Recal 

Software Utility 
GUI 

 

Once the calibration parameters are calculated, you can elect to graphically 
display the calibration and quality control (QC) standards in a graph. To do 
this, click “Plot” in the upper left corner of the window, and select “Plot 
Linear Fitting” from the drop-down menu, as shown below. 

Figure 33: 
Delta 

Recalibration  

 

 

Figure 34: 
 Slope of Delta 

Recalibration 

 

The plot that the utility will generate is shown below; this plot will display two 
graphs. The top graph presents measurements for the recalibrated 
standards (calibration and QC), as well as a line fit through those points. 
The bottom graph shows the residuals, which shows how far each 
measurement is from the best-fit line. 

If you decide to accept the new calibration values based on this plot, click 
on the “Apply New Cal” button. 
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Figure 35: 
Apply new 

calibration slope 
and intercept   

Then you will be prompted to enter a Calibration Password. The default 
Calibration Password is “Picarro”. 

Figure 36: 
User 

Authorization 
Dialog box  

 

Next, a “Recalibration Confirmation” pop-up window will appear, displaying 
the new offset and slope (when applicable) values. This window will prompt 
you to confirm your choice to apply these values, to avoid any inadvertent 
mistakes. 

Figure 37: 
Calibration 

Confirmation 
Dialog box  

 

Please note that when you press the “Yes” button, the newly accepted 
calibration parameters will take effect immediately, without the need for the 
instrument main GUI to be restarted. 

Once you accept the new calibration parameters, the Data Recal Software 
Utility automatically gives you the option to save the new recalibration file. 
Saving these files enables you to track the instrument recalibration history. 
Saved files can be reloaded by clicking “File” in the upper left corner of the 
window and selecting “Load Recalibration File.” 

Figure 38: 
Delta 

Recalibration 
Load File   



 

Picarro G2307 Analyzer User Manual  55 

Next, select the file that you want to load. 

Figure 39: 
File Browser 

Delta Recal File 
Option  

 

The recalibration file for this example will contain the following information: 

Figure 40: 
Delta Recal  

Log File 

 

-35.6 -35.8 -35.20437 

8.6 7.6 7.64690 

37.5 38.4 38.05748 

cc 1.75599 0.55625 

nc 1.87678 0.54922  

0.99949 

option Offset + 
Slope 

 

Rows 1 – 3: values from each standard selected for recalibration. The 
first column in these rows lists the certified values, the second column lists 
the measured values, and the third column lists the recalibrated values. The 
number of rows will depend on the number of standards selected to be used 
for recalibration. 

Current Calibration (cc) Row: read from left to right, list the current offset 
and current slope value. 

New Calibration (nc) Row: read from left to right, lists the new offset and 

new slope values. The third value in this row is the R2 value, which is only 
displayed if the calibration option is “offset + slope.” 

Options Row: The last row displays the calibration option selected. If you 
choose to exit the Recal GUI before accepting the new recalibration values, 
you will be prompted to confirm your choice through a pop-up window. This 
window contains a warning that continuing to exit will cause the new 
calibration data to be lost. 
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Figure 41: 
Recalibration 

Exit 
Confirmation  

 

When you are finished with the calibration, you can exit the Delta Recal 
software utility by clicking on the “Exit” button at the bottom part of the Recal 
GUI. 

Figure 42: 
Calibration  
Exit Button  

 

 

 
NOTE 

The Recal GUI displays an error saying the new slope value is not 

acceptable when (1) at least two entries in either the Certified or CRDS 

reported columns contain zero-value numbers; (2) these entries are selected 

to be used for recalibration; (3) the “offset + slope” calibration option is 

selected. This error occurs because the entered values will lead to an 

erroneous zero-slope value. 

 

Figure 43: 
Invalid New 
Slope Entry  
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12. TROUBLESHOOTING 
The following section lists problems that may be encountered during 
installation and operation of the analyzer. The corresponding step-by-step 
procedures provide resolution in most cases. If, after attempting these 
procedures, the problem remains unresolved, please contact Picarro 
Technical Support. 

12.1 Power LED on analyzer does not illuminate 

Context:  Turning on the analyzer by momentarily depressing its front panel 
power switch should apply power. The green power LED is illuminated 
when it detects the correct power levels. 

a) Check that the AC power cord is attached and plugged into a 
working outlet. 

b) Check that the rear on-off switch near the AC power cord is in the 
on position. 

c) Press and hold the front panel power switch for at least 5 seconds 
as the analyzer may take several seconds to respond. 

12.2 User Interface program does not start 

Context: The computer may be configured to start the instrument and the 
associated user interface program automatically after it completes its boot- 
up sequence, or the program may be launched using the “Start instrument” 
icon on the desktop. 

a) Communications problems with the analyzer may occur if the 
analyzer fails to initialize correctly on power up. Should the analyzer 
initialization process not complete correctly, shut down the 
instrument by shutting down the Windows operating system on 
the control computer: use the Start menu, select the red Shutdown 
button and select “Shutdown” in the drop-down box under “What do 
you want the computer to do?”. Wait for the shutdown to complete 
normally and for the computer and analyzer to turn off completely. 
After a few seconds, restart the computer by momentarily 
depressing the power button. 

 
NOTE 

Do not simply restart the Windows operating system, since this does 

not cycle the power to the analyzer. 
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12.3 Sample pressure cannot be controlled to the 
appropriate value for concentration measurements 

Context: Under normal operation, the cavity pressure is automatically 
locked to the correct value by means of electronically controlled inlet and 
outlet valves. The message “Pressure Locked” on the front panel display 
and the user interface indicates that the cavity pressure is at the 
appropriate value. Should either of the messages “Pressure high” or 
“Pressure low” be displayed, the cavity pressure is out of its correct 
operating range. 

a) The “Pressure low” message indicates that there is insufficient 
gas available at the inlet of the analyzer. Check the inlet plumbing to 
the analyzer and ensure that the pressure at the inlet is within the 
specifications. 

b) The “Pressure high” message indicates that gas cannot be 
removed from the analyzer at a sufficient rate. Check the vacuum 
line between the analyzer and the power vacuum unit for leaks. 
Failure of the vacuum pump, injecting dilution gas at excessive 
pressure, or excessive pressure at the inlet can also cause this 
problem. 

12.4 User interface program “freezes” and does not update 
graphs as data are collected. 

Context: The computer may become unresponsive causing the programs 
that control the analyzer to stop functioning. The computer and analyzer 
should be shut down and restarted. 

a) Resetting the computer and the instrument requires that the 
computer is shut down and restarted. If the computer responds to 
the mouse, a normal Windows shutdown may be carried out: use 
the Start menu, select the red Shutdown button and select 
“Shutdown” in the drop-down box under “What do you want the 
computer to do?” Wait for the shutdown to complete normally and 
for the computer and analyzer to turn off completely. After a few 
seconds, restart the computer by momentarily depressing the power 
button. 

b) Do not turn off the vacuum pump. 

c) If the computer does not respond to the mouse, hold down the 
power switch on the front panel for a few seconds until the computer 
and the instrument turn off. After another few seconds, restart the 
analyzer by momentarily depressing the power button. 
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13. SERVICE AND MAINTENANCE 

13.1 Consumables and Replacement Parts  

The following parts can be ordered directly from Picarro as needed over the 
lifetime of the analyzer. For contact information please see page 3. 

 

Part 

Number 

Description Expected Servicing 

Frequency 

S1020 Particulate filter kit for input sample line After 12 months 

C0360 Desiccant Drier Kit After 12 months 

S2009 Rebuild kit for A2000 Pump After 15,000 hours 

S2068 Complete fan replacement kit After 2-3 years 

A2000 External vacuum pump After 40,000 hours 

13.2 Particulate Filter Replacement 

There are two inline, sub-micron particulate filters before the measurement 
cavity. The first is user-replaceable and replacement filters can be 
purchased from Picarro and installed by the user. It is important to NEVER 
remove the filter that is directly attached to the cavity. Only change the filter 
immediately following the inlet at the back of the analyzer. Refer to the filter 
replacement procedure in this document for further details. 

The symptoms of a clogged filter can be analyzed reporting “pressure low” 
or there being no flow into the instrument, causing unusual measurements. 
Filters can become clogged after years of use in dirty environments.  

If liquid water is accidentally sucked into the inlet line, it will clog the filter 
and impede the flow (usually for a few days) until it evaporates. If this 
occurs, it is important to NOT turn off the analyzer or replace the filter until it 
is dry. The reason for this is that the increased humidity due to liquid water 
in the filter can cause condensation on the optics if the analyzer is allowed 
to cool from its operating temperature. Often, after the filter dries, the 
analyzer will begin functioning normally, and a filter replacement is not 
necessary. 

Tools Required 

• 1.5mm Hex driver 

• 9/16” open-end wrench 
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• 5/8” open-end wrench 

• 11/16” open-end wrench 

Removing the Old Particulate Filter 

1. Move the analyzer to a clean work environment. 

2. Using a 2 mm hex driver, remove the top lid of the analyzer by 
removing six M3 x 6mm socket flathead screws. 

3. Loosen and remove the 2 screws on the inner long side of the bigger 
box. Open the lid (see below). 

Figure 44: 
Remove 2 

screws and 
open the lid of 

the bigger inner 
box within the 

analyzer.  

 

4. Using a 5/8” wrench, loosen the retaining nut on the input bulkhead 
(about 1 full turn should be enough). 

5. Slide the foam towards the left side of the analyzer (from the back of 
the analyzer) to remove it (see below). 

Figure 45: 
Remove the 
foam cover.  

 

6. Using the 9/16” and 11/16” wrenches, loosen two nuts that are 
connecting the filter to the analyzer. 

Remove this 

screw. 

Remove this 

screw. 

Remove this 

foam. 

Loosen this 

retaining nut on 

the input 

bulkhead. 
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Figure 46: 
Nut Removal 

Process: 
Loosen the 

Fitting Nut first.  

 

 

Figure 47: 
Loosen Input 

and Output 
Filter Nuts  
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Figure 48: 
Loosen Output 

Filter Nut  

 

7. Slide the filter slightly towards the back of the analyzer and lift it out. 

Figure 49: 
Slide the old 

filter back and 
out to remove.  

 

Installing the New Filter  

 
NOTE 

When re-attaching 1/4” Swagelok fittings, the nut should be hand-

tightened and then turned an additional 1/8 of a turn using a 

wrench. 

1. Remove the filter from its packaging. 

2. Using the 9/16” and 11/16” wrenches, attach it to the two nuts. The 
arrow on the filter needs to point away from the back of the analyzer. 

Hold the 

old filter 

steady 

with a 

11/16” 

wrench. 

Loosen the 

nut with a 

9/16” 

wrench. 
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Figure 50: 
Insert the new 

filter making 
sure the 

Directional 
Arrow is 

pointing toward 
the Output Nut.  

 

3. Using a 5/8” wrench, reposition the filter foam cover and tighten the 
retaining nut on the bulkhead fitting. The metal edge of the filter 
cover should be under the foam. 

4. With a 2 mm hex driver, reattach the analyzer’s top with 6 screws. 

13.3 Case Fan Assembly Replacement 

Items/Tools Required: 

• 2 mm Hex driver 

• ¼” open end wrench 

Procedure: 

1. Completely power down the instrument. There are total of four case 
fans that are 60 mm and 40 mm respectively on the top and bottom 
of the instrument. 

2. Flip the analyzer so that it rests upside Down and the bottom layer is 
accessible. Open the bottom cover using 2 mm hex drive. 

3. Locate the PCBA. Safely remove the power connectors out from the 
PCBA. 

4. Locate the 40 mm fan assembly. Use 1/4” wrench to remove all the 
four screws and replace with the new fan.  
 

 Output 
   Nut 

New Filter 
Nut 

Retaining 

Nut 

Direction

al Arrow 

Directional 

Arrow 
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Figure 51: 
Case Fan 
Assembly 

 

5. Same procedure should be followed to replace the top side fan 
assembly. After disconnecting the power connectors on the back 
panel PCBA, flip it over to remove the front cover.  

6. Locate the 60 mm fan assembly and replace with the new fan 
assembly. 

13.4 CPU Fan Replacement 

Items/Tools Required: 

• mm Hex driver 

• Phillips Screwdriver 

Procedure: 

1. Completely shut down the instrument. 

2. Flip the analyzer so that it rests upside-down and the bottom layer is 
accessible. 

3. Open the bottom cover. 

4. Locate the Mother Board.  Locate the CPU fan, unscrew all four 
corner screws and Replace with the new fan. 
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Figure 52: 
CPU Fan 

 

13.5 Replacing Vacuum Diaphragms and Valves 

 
CAUTION 

Never operate the pump if covers or other parts of the pump are 

disassembled. Never operate a defective or damaged pump. Check every 

motor capacitor regularly by measuring its capacity and estimating its 

service life. See A2000 Pump Manual for more information and servicing 

instructions. 

Overview 

The valves and diaphragms as well as the motor capacitors are wear parts. 
If the rated ultimate vacuum is no longer achieved or in case of increased 
noise level, the pump interior, the diaphragms and the valves mist be 
cleaned and checked for cracks or other damage.  

All bearings are encapsulated and are filled with long-life lubricant. Under 
normal operating conditions, the drive system is maintenance free. In 
demanding circumstances, it may be efficient to check and clean the pump 
heads on a regular basis. In normal use, the lifetime of the diaphragms and 
valves is typically 15,000 operating hours.  

 
CAUTION 

Prevent internal condensation, transfer of liquids or dust. The diaphragms 

and valves will be damaged if liquid is pumped in significant amount. Carry 

out maintenance frequently if the pump is exposed to corrosive media or in 

case of deposits. 

 

 
CAUTION 

Service only one side of the pump at a time to avoid the mixing of parts. 

Phillips screw 
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Required Tools 

A Pump Rebuild Kit (part number S2009) can be ordered directly from 
Picarro and includes 4 diaphragms, 8 valves, a 46 mm diaphragm key, and 
a silicone rubber tube for the pump’s silencer.  

In addition to the above, you will also need the following tools: 

• 15 mm open-end wrench  

• 4 mm Allen key 

• Phillips screwdriver size 2 

Safety Requirements 

Follow the safety precautions as described in Section 4, “Safety.” 

Checking Diaphragms and Valves 

Before starting the procedure, familiarize yourself with the different parts 
involved as outlined below: 

 

Figure 53: 
Diagram of the 

diaphragms and 

valves in A2000 

 

 

Position Component 

1 Housing cover 

2 Valves 

3 Head cover 
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4 Diaphragm clamping disc with square head screw 

5 Diaphragm 

6 Diaphragm support disc 

7 Washers 

8 Connecting rod 

9 Housing 

1. Use the 15 mm open end wrench to loosen the nut holding on the 
housing cover. 

Figure 54: 
Loosen the nut 

securing the 

housing cover 

 

2. With the Phillips screwdriver, remove the two screws at the base of 
the pump handle and then carefully dislodge and remove the 
handle. 

Figure 55: 
Removing  

the handle 
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3. Using the 4 mm Allen key, loosen and remove the 6 screws in the 
housing cover.  

4. Remove the housing cover and set aside.  

Figure 56: 
Remove the 

housing screws 

and then the 

housing cover 

 

5. Remove the head cover and valves you would like to inspect. It is 
recommended to only service one side at a time. 

 

Figure 57: 
Visually inspect 

the valves 
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Figure 58: 
Removing the 

valves from the 

head cover 

 

6. Carefully remove the valves and clean if necessary. Do not use 
sharp instruments to remove the valves. If the valves appear worn 
or show damage, replace with new valves provided in the S2009 
Pump Rebuild Kit. 

 

Figure 59: 
Signs of 

damage to the 

valves and 

diaphragm 
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Replacing the Diaphragm 

1. Carefully fold in the edges of the diaphragm to reveal the diaphragm 
support disc below. Do not use any sharp tools as this can damage 
the diaphragm. 

 

Figure 60: 
Lift the edges of 

the diaphragm 

 

2. Align the 46 mm diaphragm key with the edges of the diaphragm 
support disc.  

 

Figure 61: 
Align the 

diaphragm key  
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3. Apply pressure on the diaphragm key and turn counter clockwise to 
release the diaphragm clamping disc. As you remove the 
components be sure to note the order they are removed in and the 
number of washers. 
 

Figure 62: 
Order of 

components 

beneath the 

diaphragm 

clamping disc 

 

4. Replace the old diaphragm making sure to place it with the blue side 
of the diaphragm facing the diaphragm clamping disc. 
 

Figure 63: 
Correct 

diaphragm 

orientation 

 

5. Align the square head of the diaphragm clamping disc with the 
opening on the diaphragm support disc and make sure it is properly 
seated. 

6. Replace any washers as necessary. 



 

72   Picarro G2307 Analyzer User Manual 

7. Using the diaphragm key, locate the connecting rod and reseat the 
diaphragm clamping disc, diaphragm, and diaphragm support disc.  
 

Figure 64: 
Confirm the 

number of 

washers  

 

8. Apply pressure and turn the diaphragm key clockwise to secure the 
components.  

Replacing the Valves and Assembling Pump Heads 

 

Figure 65: 
Visually inspect 

diaphragms 
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1. Visually inspect both diaphragms, they should be properly seated 
and locked in prior to replacing the head covers. 

 

Figure 66: 
Replace head 

covers above 

diaphragms 

 

2. Replace the head covers and valves over the diaphragm clamping 
discs. 

 

Figure 67: 
Replace 

housing cover 

 

3. Replace the housing cover.  

4. Align the housing cover with the screw holes in the housing.  
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5. Replace all six screws. Screw in manually at first and then use the 4 
mm Allen key to tighten. 

6. Use the 15 mm open end wrench to tighten the nut connecting the 
housing and housing cover.  

 

Figure 68: 
Replace handle 

and align 

screws 

  

7. Reseat the handle on top of the housing cover and align the screw 
holes.  

8. Use the size 2 Phillips screwdriver to screw and tighten both screws 
at the base of the handle. 

9. Make sure that the edge of the handle does not hang over the edge 
of the housing cover as you tighten the screws.  

Checking the Ultimate Vacuum 

After any intervention at the equipment (e.g., repair or maintenance) the 
ultimate vacuum of the pump has to be checked. Only if the pump achieves 
its specified ultimate vacuum, the pump’s leak rate is low enough to ensure 
that no explosive atmospheres will occur in the interior of the equipment.  

If the pump does not achieve the ultimate vacuum: 

• Whenever the diaphragms and valves have been replaced, a break-
in period of several hours is required before the pump achieves its 
ultimate vacuum.  

• In case of an unusual noise, switch off pump immediately and check 
camping disc positions.  

• If the ultimate vacuum is not achieved after break-in period, check 
hose connectors at pump heads for leaks.  

• If necessary, recheck valve seats and pump chambers.  
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13.6 Cleaning 

Clean the outside of the analyzer with a clean dry cloth. Only certified 

service technicians should access or clean the inside of the analyzer. 
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14. TRANSPORTATION AND STORAGE 
In the event that the instrument will be transported or stored, the following 
procedure can be used to prepare the instrument and repack it into the 
original packaging. 

14.1 Packing the Analyzer 

1. Shutdown the instrument using the shutdown button, using the 
“prepare for shipment” option.  Clean dry gas should be attached to 
the instrument prior to shutting down.  This prevents condensation 
inside the system during storage or shipment. 

2. Disconnect all tubing and electrical connections from the analyzer. 

3. To prevent contamination and possible damage to the connector 
threads, place caps on all gas connections. 

4. Place the analyzer in a plastic bag with a package of desiccant.  
Seal the bags with tape. 

5. Pack the analyzer in the original shipping container ensuring that all 
the foam pieces are in place to protect the analyzer during shipping. 

  
CAUTION 

When shipping or relocating the analyzer, it is important to protect it 

from mechanical shocks. Failure to do so can compromise its 

performance. When shipping the analyzer, use its original packaging 

only. 
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15. LIMITED WARRANTY 
Picarro, Inc. warrants its products to be free from defects in material and 
workmanship and to perform in the manner and under the conditions 
specified in the Product specifications for twelve (12) months from 
shipment. 

This warranty is the only warranty made by Picarro with respect to its 
Products and no person is authorized to bind Picarro for any obligations or 
liabilities beyond this warranty in connection with its Products. This warranty 
is made to the original Purchaser only, is nontransferable and may only be 
modified or amended by a written instrument signed by a duly authorized 
officer of Picarro. Sub-systems manufactured by other firms, but integrated 
into Picarro Products, are covered by the original manufacturer’s warranty 
and Picarro makes no warranty, express or implied, regarding such sub-
systems. Products or parts thereof which are replaced or repaired under 
this warranty are warranted only for the remaining, unexpired portion of the 
original warranty period applicable to the specific Product replaced or 
repaired. Products or parts thereof which are replaced or repaired outside of 
this warranty are warranted only for ninety days. 

 
NOTE 

THE FOREGOING WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL 

OTHER WARRANTIES WHETHER WRITTEN, ORAL OR IMPLIED, AND 

SHALL BE THE PURCHASER’S SOLE REMEDY AND PICARRO’S SOLE 

LIABILITY IN CONTRACT OR OTHERWISE FOR THE PRODUCT. 

PICARRO EXPRESSLY DISCLAIMS ANY WARRANTY OF 

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 

The Purchaser’s exclusive remedy with respect to any defective Product 
shall be to have Picarro repair or replace such defective Product or credit 
the Purchaser’s account, whichever Picarro may elect in its sole discretion. 
If it is found that any Product has been returned which is not defective, the 
Purchaser will be notified, and such Product returned at the Purchaser’s 
expense. In addition, a charge for testing and examination may, at Picarro’s 
sole discretion, be made on any Product so returned. 

These remedies are available only if: i) Picarro is notified in writing by the 
Purchaser promptly upon discovery of a Product defect, and in any event 
within the warranty period; ii) Picarro’s examination of such Product 
discloses to Picarro’s satisfaction that such defects actually exist and the 
Product has not been repaired, worked on, altered by persons not 
authorized by Picarro, subject to misuse, negligence or accident, or 
connected, installed, used or adjusted otherwise than in accordance with 
the instructions furnished by Picarro. 
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16. APPENDIX A – REMOTE DATA ACCESS 

The Picarro Serial Communication 

The analyzer supports an RS-232 physical command interface, which can 
be used to control the instrument and to retrieve concentration data. Not all 
features of the instrument are available on the serial interface. For details 
on how to use the serial command interface, please see the Picarro 
Analyzer Programming Guide (included in PDF format on the installation 
CD). This command set may also be used across a TCP/IP interface 
through an Ethernet connection.  

Remote Data Access 

Using the RemoteAccess.ini file, the analyzer can be configured to 
automatically: 

• Send data from the instrument to a list of e-mail accounts. 

• Measure the offset of the host computer system clock from a set of 
Internet time servers and (optionally) to resynchronize the clock 
based on this information. 

The Internet connection need not be permanent and may be a dial-up 
connection accessible via a user-supplied USB modem. The task of 
sending data and/or synchronizing the clock on the analyzer is performed 
using the executable program file:  

C:\Picarro\G2000\HostExe\RemoteAccess.exe  

This program can be set up to run periodically using the Windows task 
scheduler at a user-configurable frequency. If a dial-up connection to the 
Internet is employed, it is used only on demand to minimize the connection 
time. 

Each time that the RemoteAccess.exe program runs it appends information 
to a log file that keeps a record of the results of the time synchronization 
and of the files sent by e-mail. The RemoteAccess.exe program is 
configurable by means of an initialization file, which includes information 
such as the login credentials for the dial-up connection, the e-mail account 
and the list of time servers. The initialization file is: 

C:\Picarro\G2000\AppConfig\Config\UtilitiesRemoteAccess\RemoteAccess.i
ni 

RemoteAccess.ini should be placed in the same directory as the executable 
program file RemoteAccess.exe. The file has one required section named 
LOGGING and three optional sections named NTP, DIALUP, and EMAIL. 
The logging section has a single key Logfile whose value is the path to the 
log file. Once this log file exceeds 64K bytes in length, it is backed up, 
appending a numeric extension to the file name, and a new file is opened. A 
total of ten backup log files are kept. 
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NTP 

The NTP section controls querying the Internet time servers using the 
SNTP protocol (RFC4330) and the resetting of the clock on the host 
computer. If the section is not present, time synchronization is not carried 
out. 

• Server1, Server2…: used to specify the URLs of the time servers.  

• UpdateClock: if key is set to “true,” the offset is applied to the host 
clock. Otherwise, the offset is recorded, but the host clock is not 
changed. 

Email 

The EMAIL section controls the sending of the data files as e-mail 
attachments. If the section is not present, e-mail messages are not sent. 
This section contains the following keys: 

• Directory: specifies the directory that contains the data files. When 
the program is run, files in this directory are sent to the specified 
recipients and the files are deleted. To avoid problems with 
incomplete files, programs that place files into this directory should 
do so using an atomic operation, such as a rename.  

• Server: specify an RFC2821-compliant SMTP server that sends the 
e-mail messages. 

• From: specify the e-mail address from which the messages are sent. 
Note that some SMTP servers check that the source is permitted to 
send email while others allow any name in this field.  

• To1, To2…: specify the e-mail addresses to which the e-mail is sent.  

• Subject: fill the subject field in the email header and may be set to 
any string.  

• UseAuthentication: Depending on the SMTP server, it may be 
necessary to use authentication before e-mails can be sent, as 
described in RFC2554. If such authentication is not needed, the key 
is set to false. If this key is set to true, two additional keys Username 
and Password must also be specified for the e-mail account. 

Dial-up 

The DIALUP section is used if a dial-up connection to the Internet needs to 
be established when the program runs. If the section does not exist, a 
permanent connection is assumed to be available for carrying out the other 
tasks specified in the initialization file.  

• Connection Name: specifies the name of the dial-up connection to 
use, as listed under Network Connections in the Control Panel. 
Username and Password must also be specified to make the 
connection. 
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Examples of “RemoteAccess.ini” File 

 
[LOGGING] 

Logfile=c:/temp/RemoteAccessLog 

 

[NTP] 

Server1=time-a.nist.gov 

Server2=time-b.nist.gov 

Server3=time-a.timefreq.bldrdoc.gov  

Server4=time-b.timefreq.bldrdoc.gov 

Server5=time-c.timefreq.bldrdoc.gov 

Server6=time.nist.gov 

Server7=time-nw.nist.gov 

UpdateClock=1 

 

[DIALUP] 

ConnectionName=Picarro Dialup Access 

Username=user 

Password=password 

Number=14085551212 

 

[EMAIL] 

Server=smtp.servername.org 

Directory=c:/picarro/mailbox 

From=instrument@picarro.com 

To1=recipient1@site1.com 

To2=recipient2@site2.com 

Subject=CRDS data from Picarro instrument 

UseAuthentication=0 
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17. APPENDIX B – THE DATA FILE VIEWER 
The Picarro Data File Viewer software is located in the Picarro Utilities 
folder on the desktop. The software allows the user to graph and to conduct 
statistical analysis of the raw data. Additional functions include Allan 
Variance plot and quadratic or polynomial fittings.   

The Picarro Data File Viewer includes two main menus: File and New. 

Figure 69: 
File Menu 

 

 

Figure 70: 
New Menu  

 

THE FILE MENU 

This section describes the functions available from the Data File Viewer File 
menu. 

Open H5 

File > Open H5 opens a Picarro data file (HDF5 format) for data analysis and 
visualization. After opening the data file, you can create a new time series 
plot. Refer to New Time Series Plot for more information. 

Load Config 

File > Load Config loads a configuration file (ini format) to restore parameters 
of a workplace. Refer to Save Configuration for more information. 

Unpack Zip File 

Use File > Unpack Zip File to concatenate all H5 files inside the zip file into a 
single H5 file. Refer to Concatenate H5 Files for details. 
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Concatenate H5 Files 

Use File > Concatenate H5 files to concatenate multiple files and zip 
archives of H5 files into a single H5 file. Navigate to the desired folder or use 
the Define date range button to specify a date range of files to concatenate. 
(See next section.) 

After selecting the path of the data files, Data File Viewer will automatically 
search an H5 file in the specified zip/folder and look for all available variables 
in the H5 file. The variables are then listed in the left panel, and users can use 
“>>” button to move variables to the right panel for concatenation. 

Figure 71: 
Select Variables 

Form  

 

Define Date Range 

Data File Viewer can search data files within the desired date range and 
then concatenate such files into an H5 file. 

By default, TimeZone is set to your local time zone. However, if data were 
taken elsewhere, select the time zone where data were taken. 

Select File > Concatenate H5 files, then click Define date range to specify 
the desired date range. 
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Figure 72: 
Defining Date 

Range  

 

Data files are saved in directory trees named by date and time option. 
Picarro software saves data in a directory tree that is named by the creation 
year, month, and day. Select this option if the target folder has this file 
structure. This way, Data File Viewer will only search folders within the 
desired date range, which can substantially reduce processing time. 

Figure 73: 
File Structure of 

Data File 
Viewer  

 

 

 
NOTE 

To save processing time, Data File Viewer does not open data files, but only 

determines data acquisition time based on the file name. 

 

 
CAUTION 

Do not define a time range for data files whose names have been changed. 

 

 
NOTE 

Data File Viewer does not concatenate data files exactly within the defined 

time range. This is because the time extracted from file name is different 

from the data acquisition time. To not miss data points, Data File Viewer 

expands the specified time range, so the resulting dataset normally has a 

wider time range than the user specification. 
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Convert DAT to H5 

Select File > Convert DAT to H5 to convert a file in DAT format to HDF5 
format. These formats are described below: 

• DAT format: DAT files accepted by DatViewer store tabular data 
(numbers and text) in plain text. Each line of the file is a data record. 
Each record consists of one or more fields separated by 
whitespaces. The first line of data file indicates column names. 

There must be a field “EPOCH_TIME” to store the acquisition epoch time 
(expressed as seconds since Jan 1, 1970) of the data. Otherwise, the first 
and second fields must be “DATE” and “TIME”. The “DATE” field must have 
the format “mm/dd/yyyy” or “yyyy-mm-dd”, and the “TIME” field must have 
the format “HH:MM: SS(.sss)” where (.sss) is an optional fraction of 
seconds. 

• HDF5 format: HDF5 is a data model, library, and file format for 
storing and managing data. (See the HDF5 Home Page on the HDF 
Group Web site for more information.) When converting DAT to 
HDF5 format, Data File Viewer creates a table named “results” to the 
contained data. 

Convert H5 to DAT 

Select File > Convert H5 to DAT to convert a file in a HDF5 format to DAT. 
These formats are described in Convert DAT to H5. 

 
NOTE 

Data File Viewer does not concatenate data files exactly within the 

defined time range. This is because the time extracted from file name is 

different from the data acquisition time. Data File Viewer expands the 

specified time and column name “fineLaser-Current_1_controlOn” with 

“fineLaserCurr_1_ctrlOn”. 

Interpolation 

Interpolation describes the method for constructing data points with a range 
of a discrete set of known data points. Select File > Interpolation to 
perform interpolation on a time grid with a constant interval. 

Block Average 

Select File > Block Average to divide a dataset into small blocks based on 
a user-defined block size. The average is calculated for data in each block, 
and the results are saved in a new H5 file. 

 
NOTE 

The specified block size must be greater than the average data interval. 
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Because the data interval is normally not a constant (unless interpolation is 
performed), fluctuations in the data interval will affect block averaging if the 
block size is comparable to the average data interval. 

NEW TIME SERIES PLOT 

You can specify to include create time-series plots with one, two, or three 
frames. New plots display in the Time Series Viewer. 

Figure 74: 
Time Series 

Viewer  

 

The next section describes the options available on the Time Series Viewer 
menu bar. Refer to Time Series Viewer Canvas on page 88 for information 
the Time Series Viewer UI features and options. 

Time Series Viewer Menus 

The Time Series Viewer form includes the following menus: 

Figure 75: 
Time Series 

Viewer Menus  

 

Time Series Viewer File Menu 

Use the File menu to save a configuration or take a screenshot. 

Figure 76: 
Time Series 

Viewer – File 
Menu  
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Save Configuration 

Click File > Save Configuration to open the Feature Capture form. With this 
form, you can save figure properties, expressions, filters, and other settings to 
a configuration file so that it can be easily loaded in the future. 

Figure 77: 
Time Series 

Viewer – 
Feature Capture  

 

 

 
CAUTION 

If a feature is not captured, it will be omitted when the configuration file is 

loaded. 

Depending on the features captured, loading a configuration file can have 
different effects. For example: 

• If all features are captured, a saved workplace is reproduced. 

• If Data file is not captured, saved parameters will be applied to the 
data file in memory. 

• If Expression is not captured, plots will not be transformed. 

• If X (Y) range is not captured, figures will be auto-scaled on the x (y) 
axis. 

Take ScreenShot 

Use File > Take ScreenShot to take a screenshot of the Time Series 
Viewer and save it as a PNG file to a specified filename. 

Time Series Viewer Analysis Menu 

Use the Analysis menu to calculate statistics, generate a histogram, and to 
plot correlations and Allan Standard deviations. 
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Figure 78: 
Time Series 

Viewer – 
Analysis Menu  

 

Statistics 

Use Analysis > Statistics to calculate mean, standard deviation and peak 
to peak for all plots in the current window. 

Histogram 

Use Analysis > Histogram to generate a histogram of data as shown 
below. 

Figure 79: 
Histogram 

Window  

 

• Red Line: A Gaussian function fitted to the histogram. Fitting results 
of μ and σ are shown in the top-left corner of the plot. 

• Bin: Specifies the number of intervals that the range of values is 
divided into. 

• Normalized: When selected, the sum of the histograms is 
normalized to 1. 

• Save data: Saves histogram data to a CSV file. 
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• Save image: Saves the histogram image as a JPEG/PNG/PDF file. 

Correlation Plot 

Use Analysis > Correlation Plot to plot Y-axis data in one frame versus 
that in the other. This can be used when two or more frames exist in the 
current Time Series Plot window. See Correlation/XY Plot for details. 

Allan Standard Deviation Plot 

Use Analysis > Allan Standard Deviation Plot to create an Allan 
Standard Deviation plot (versus a standard deviation plot) for data in the 
current window. See Allan Variance for more information. 

Time Series Viewer View Menu 

Use the View menu to view X-axis information in date-time, minute, or hour 
format. 

Figure 80: 
Time Series 

Viewer –  
View Menu  

 

 

 
NOTE 

When switching from DateTime to Minute or Hour, the X-axis data is 

subtracted from the earliest point shown in the panel and then converted to 

the desired unit.  

The Time Series Viewer Canvas 

The Time Series Viewer canvas is comprised of interactive graphs and a 
variety of configuration options. 

https://en.wikipedia.org/wiki/Allan_variance
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Figure 81: 
Time Series 

Viewer Canvas  

 

Mouse Options and Graph Transform 

The following mouse actions can be used in the canvas graphs: 

• Left click and drag: Zooms into the selected area of the plot. 

• Left click and drag with the SHIFT key down: Pans the plot. 

• Left click and drag with CTRL key down: Zooms out from the plot. 

• Left click and drag with ALT key down: Stretches the plot. 

• Right-click: Opens an additional menu. Refer to the next section. 

Right-click Menu 

Right-clicking on the canvas provides opens a pop-up menu. 

Figure 82: 
Canvas Right-

click Menu  

 

Export Image: Exports the current plot as a JPEG, PNG, or PDF file. 

Export Data in Current View: Exports only date/time and the selected 
variable in the current view to an HDF5 or CSV file. 

Export All Data in Current Time Range: Exports all variable columns of 
the selected dataset in the current time range to an HDF5 file. Refer to 
Concatenate H5 Files on page 82 for more information. 

Edit Plot properties: Opens the Image Editor form, where the following 
options can be specified: 
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• Title: Edits the title of the plot. 

• Line: Specifies the line pattern of the plot. If None is selected, the 
data points will be plotted without connecting lines. 

• Marker: Specifies the marker type to indicate data points. If None is 
selected, data points will not be shown. 

• Min and Max: Specifies the minimum and maximum of data range 
for the X-axis and the Y-axis. 

• x[0]: Sets the earliest time of the dataset as the minimum of the X-
axis. 

• Time zone: Sets the time zone for date/time variables. This defaults 
to the local time zone. 

• Label: Specify a label for the X-axis and the Y-axis. 

Figure 83: 
Image Editor 

Form  

 

Statistics: Calculates the mean, standard deviation, and peak to peak for 
data in the current view. 

Dataset Name and Var Name 

An HDF5 file can store one or more tables. Each of these tables is called a 
Dataset. A table can contain one or more columns. Each column is called a 
variable (Var). 

Use the Dataset name drop down menu to select the dataset that will be 
used for this time series graph. Use the Var name drop down to select the 
column in the dataset to use in the graph. 

Autoscale Y 

When the Autoscale Y option is selected, the Time Series Viewer will 
autoscale on the Y-axis to make sure that all data within the range of the X-
axis is displayed. 
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Average 

If Block is selected, a block average is calculated when you click the Do 
average button is clicked. Otherwise, a moving average is calculated. 

For a block average, Size specifies block size in unit of a minute. For a 
moving average, Size specifies subset size in unit of data points. 

 
REMINDER 

Averaging is performed after the Filter and Expression are performed. 

Mean, Std Dev, and Peak to Peak 

The Mean, Std dev (Standard deviation) and Peak to peak fields provide 
all the statistical information of data in the current view. 

Correlation/XY Plot 

The Correlation/XY Plot window includes two menu items: File and Analysis. 
For details about the File menu, see Save Configuration on page 86. 

 
REMINDER 

The canvas in this plot is interactive. For details about the plot canvas, 

see The Time Series Viewer Canvas on page 88. 

 

Figure 84: 
Correlation/XY 

Plot 
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Analysis Menu 

The Analysis Menu includes three options: 

• Fitting allows you to specify one of four fitting methods to include in 
the Correlation/XY plot: 

i. Linear fit: Specifies to fit to linear function y = c1x + c0 

ii. Quadratic fit: Specifies to fit to quadratic function y = c2x2 + 
c1x + c0 

iii. Polynomial fit: Specifies to fit polynomial function of degree 
n: y = Σcnxn 

iv. Curve fit: Specifies to use non-linear least squares to fit an 
arbitrary function to data.  

Figure 85: 
Analysis  

Menu 

 

 

• Integration calculates area under the curve using the composite 
trapezoidal rule. 

• Statistics calculates mean, standard deviation, and peak to peak for 
data in the current view.  

After applying any of the above Analysis options, the results, statistics, or 
fitting function with coefficients are displayed in the lower portion of the 
Correlation Plot window.  

 

Figure 86: 
Results of 
Quadratic 

Fitting 
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18. APPENDIX C – EXTERNAL VALVE 
SEQUENCER 

The Picarro analyzer can control two types of valves: 

• Solenoid valve(s): DC voltage powered valve with normally open 
(NO) and normally closed (NC) positions. These can be either 2-way 
or 3-way valves. 

• Rotary Selector valve: digitally controlled valve used to send 
selected flow from one of many inputs (up to 32) into the analyzer 

Both types of valves can be simultaneously controlled through a common 
software interface called the ‘External Valve Sequencer,’ which is available 
from the Tools menu in the GUI. 

Default Configuration 

For all models of Picarro analyzers, the rotary valve control is disabled in 
the factory default setting. The solenoid valve control, however, is ready to 
use by default for all solenoid valve connectors. 

Setting Up Solenoid Valves 

The Valve Sequencer software can control up to six solenoid valves. Each 
valve should operate using 12 VDC with a current requirement of <1.5 
Ampere maximum. This analyzer comes with a cable that can be connected 
to the solenoid valves. 

The valve connector cable should be connected to the 15-pin connector at 
the lower left corner of the analyzer. There are six pairs of wires with 
connectors labeled V1, V2, … V6 with 2-pin female Molex connectors 
(Molex#43020-0200) for connection to the solenoid valves. For valves wired 
with matching Molex connectors, connect V1 to the solenoid valve 1, V2 to 
solenoid valve 2, etc. Do not connect the solenoid valve to the analyzer 
ground -- use only the provided electrical connectors. 

Setting Up Rotary Selector Valve 

A multi-position rotary selector valve can be controlled by the Valve 
Sequencer software. It is controlled by standard serial commands in the 
Valco (VICI) protocol. Valco rotary valve models SD, SC, SF, ST, and STF 
are all supported. However, not all configurations will be appropriate, due to 
tube diameter, pressure or materials of construction. This setup will also 
require a Valco micro electric high torque actuator. A single combination 
package such as EMT2ST16MWE includes a 16 position, low- pressure ST 
valve in stainless steel, 1/8” tubing, 2” standoff, and micro electric high 
torque actuator. Please refer to http://www.vici.com/vval/st_8-1.php#16pos 
for further options and consult with Valco directly for more details. 

http://www.vici.com/vval/st_8-1.php#16pos
http://www.vici.com/vval/st_8-1.php#16pos


 

94   Picarro G2307 Analyzer User Manual 

The Valco controller should be installed per manufacturer’s instructions. 
The 9-pin female, connector cable (female) should mate with its 
corresponding, male port of the analyzer and labeled “MPV.” Please note 
the 9-pin connector cable is not supplied with the instrument. 

Figure 87: 
8-port Valve 

Setup  

 

Valve Sequencer Software 

The Valve Sequencer software allows the user to set steps in which 
solenoid valves are turned on/off and the rotary selector valve is set to a 
single position. The Picarro valve sequencer window appears below: 
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Figure 88: 
Valve 

Sequencer GUI  

 

The current step, elapsed duration, and valve states are shown in the 
topmost row of the valve sequencer command window. The duration of 
each step is set in minutes; for example, 1 minute and 30 seconds 
correspond to 1.5 minutes. 

Please note the number of steps correlates with the total steps in the 
sequence, and the count of the steps starts at “0.” The first step in the 
sequence is designated Current Step “0,” and the second step in the 
sequence is designated Current Step “1.” The “Go to First Step” menu item 
under “Action” restarts the sequence from step 1. 

Different sequences can be created and saved in the software. Use the 
“Sequence File #” field to select which file the sequence will be saved to (0 
to 10 are the available choices). Click the up/down arrows to select the 
desired number. 

Configuring a Valve Sequence 

Each “step” sets the rotary valve to a single position and activates the 
indicated solenoid valve(s) for a set period. Multiple steps can be carried out 
in sequential order to switch between different gas sources, flush out a 
manifold, or other gas handling operation. Create the number of desired 
steps in the sequence by clicking the up/down arrow for “steps.” 

For each step, select the box for each solenoid valve to be opened. The 
checkmark in the “current valve state” window indicates a solenoid valve is 
open. Note: In this example, we assume normally closed (NC) valves are 



 

96   Picarro G2307 Analyzer User Manual 

used. A check indicates current is flowing to the valve thus powering it 
open. The positions from left to right correspond to solenoid valves V1…V6. 

The rotary selector valve position can be set in the column labeled “Rot. 
Valve Code.” Enter the number that corresponds to the desired valve 
position. A value of 1 in this field corresponds to position 2 on the Valco 
valve. Only one rotary position can be selected per step. 

Step duration is determined by the value entered in the “duration (min)” 
field, where the duration of the step is in minutes. If duration values are set 
to <0.1 minutes, they may not be carried out correctly. 

The “valve code” field is a configuration- dependent, read-only display field 
that shows the total state of that particular step in a numerical code. Should 
the most upper right gray box display a value of 512,256 or be grayed-out, 
either no rotary selector valve is connected to the instrument, or the valve is 
not functioning. For each individual measurement, the analyzer makes, the 
valve codes and rotary valve positions corresponding to the valve state(s) at 
that point in time are saved alongside the concentration data. 

Once the valve sequence has been programmed, it can be saved using the 
button “Save Valve Sequence File.” The sequence will be saved under the 
sequence file number selected. 

Loading and Running a Saved Sequence 

To load a valve sequence file, select the desired “sequence file number” 
and press “Load Valve Sequence File.” If the user has been running a 
different sequence from the one that was loaded, the user needs to press 
“Next Step” to initialize the newly selected sequence. 

To run a sequence file, press “Enable Sequencer.” This button will turn to 
“Disable Sequencer” once the sequence starts. (The sequencer should be 
activated if it was disabled, but not necessarily to change from one 
sequence to another.) The sequence will repeat itself indefinitely until 
disabled or the software is exited. If enabled, the sequence will continue to 
run after the “close sequencer window” button is pressed. 

If desired, the valve sequence can be forwarded to the next step of the 
sequence by pressing the “run next step” button. To stop the sequencer file, 
use the “Start/Stop Sequencer” menu item under the “Action” menu. This 
will leave all valves in their current state. In some situations, it is convenient 
to program the last step in the sequence to be a safe or default valve state. 
The sequencer can be advanced to the last step should the user need to 
put the solenoid or rotary valves into a safe/default state. The “Reset All 
Valves” de-activates all valves. Using the “Hide Sequencer Interface” closes 
the window, but if the sequencer is enabled, it will continue to run in the 
background. To jump to a particular step, increment the “run step 3” and 
click “Apply.” 

Both solenoid and rotary valve codes are recorded in columns in the output 
data files indicating the active valve configuration respective to when data is 



 

Picarro G2307 Analyzer User Manual  97 

taken. These codes can be used as event timing flags. For example, if no 
solenoid valves are present, the codes will be recorded regardless of 
whether a valve is connected or not. 
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19. APPENDIX D – DATA LOG PARAMETERS 
Below is a generic example of DataLog Parameters 

Column Description Units (if applicable) 

DATE Date of measurement(UTC) Year-Month-Day 

TIME Time of measurement (instrument time, GMT) Hour:Minute:Second.m

s 

FRAC_DAYS_SINCE_JAN1 Fraction of days since Jan 1 (max = 365)  - 

FRAC_HRS_SINCE_JAN1 Fraction of hours since Jan 1 (max = 8760)  - 

JULIAN_DAYS Julian days in since Jan 1 00:00 GMT  - 

EPOCH_TIME Number of seconds that have elapsed since Jan 1, 1970 

GMT 

 - 

ALARM_STATUS Binary system alarm (0 = no alarm; 1 = alarm)  - 

INST_STATUS Hardware status code; should always equal 963 if the 

analyzer is operating properly 

 - 

CavityPressure Cavity Pressure Torr 

CavityTemp Cavity Temperature deg C 

DasTemp Temperature measured on the data acquisition system 

board 

deg C 

EtalonTemp Temperature measured at the WLM dec C 

WarmBoxTemp Temperature measured at the warm box deg C 

Species - - 

MPVPosition Integer code for the valve position  - 

OutletValve DAC output to proportional valve at cavity outlet DN 

Solenoid_valves - - 

H2CO Mole fraction of formaldehyde, corrected for effect of 

water vapor 

PPM 
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H2CO_30s 30-s averaged mole fraction of formaldehyde, corrected 

for effect of water vapor 

PPM 

H2CO_2min 2-min averaged mole fraction of formaldehyde, corrected 

for effect of water vapor 

PPM 

H2CO_5min 5-min averaged mole fraction of formaldehyde, corrected 

for effect of water vapor 

PPM 

H2O Mole fraction of water vapor Percent 

CH4 Mole fraction of methane, not corrected for effect of 

water vapor 

PPM 

 

DataLog_Private Parameters 

Column Description Units (if applicable) 

DATE Date of measurement(UTC) Year-Month-Day 

TIME Time of measurement (instrument 

time, GMT) 

Hour:Minute:Second.ms 

ALARM_STATUS Binary system alarm (0 = no alarm; 1 

= alarm) 

 - 

AccelX - - 

AccelY - - 

AccelZ - - 

AmbientPressure Not used  - 

Battery_Charge Proxy for charge held in battery Coulombs 

Battery_Current Current output of battery Ampere 

Battery_Temperature Temperature of battery deg C 

Battery_Voltage Voltage output of battery Volt 

CH4 Mole fraction of methane, calibrated 

but not corrected for effect of water 

vapor 

ppm 

CavityPressure Cavity Pressure Torr 
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Column Description Units (if applicable) 

CavityTemp Cavity Temperature deg C 

CavityTemp1 Not used - 

CavityTemp2 Not used - 

CavityTemp3 Not used - 

CavityTemp4 Not used - 

DasTemp Temperature measured on the data 

acquisition system board 

deg C 

Etalon1 ADC output from photodiode 

monitoring etalon 1 transmission in 

wavelength monitor (WLM) 

DN 

Etalon2 ADC output from photodiode 

monitoring etalon 2 transmission in 

WLM 

DN 

EtalonTemp Temperature measured at the WLM dec C 

FRAC_DAYS_SINCE_JAN1 Fraction of days since Jan 1 (max = 

365) 

 - 

FRAC_HRS_SINCE_JAN1 Fraction of hours since Jan 1 (max = 

8760) 

 - 

FanState Binary output fan (off/on)  - 

Flow1 Not used  - 

H2CO Mole fraction of formaldehyde PPM 

H2CO_30s 30-s averaged mole fraction of 

formaldehyde, corrected for effect of 

water vapor 

PPM 

H2CO_2min 2-min averaged mole fraction of 

formaldehyde, corrected for effect of 

water vapor 

PPM 

H2CO_5min 5-min averaged mole fraction of 

formaldehyde, corrected for effect of 

water vapor 

PPM 

H2O Mole fraction of water vapor Percent 
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Column Description Units (if applicable) 

HotBoxHeader DAC output to hot box heater 

controller 

DN 

HotBoxHeatsinkTemp Temperature measured at the hot 

box heatsink 

dec C 

HotBoxTec DAC output to hot box thermoelectric 

cooler 

DN 

INST_STATUS Hardware status code; should always 

equal 963 if the analyzer is operating 

properly 

 - 

InletValve DAC output to proportional valve at 

cavity inlet 

DN 

JULIAN_DAYS Julian days since Jan 1 00:00 GMT  - 

Laser1Current Current to Laser 1 mA 

Laser1Tec DAC output to Laser 1 thermoelectric 

cooler 

DN 

Laser1Temp Temperature of Laser 1 dec C 

Laser2Current Current to Laser 2 (not used on this 

analyzer) 

mA 

Laser2Tec DAC output to Laser 2 thermoelectric 

cooler 

DN 

Laser2Temp Temperature of Laser 2 dec C 

Laser3Current Current to Laser 3 (not used on this 

analyzer) 

mA 

Laser3Tec DAC output to Laser 3 thermoelectric 

cooler 

DN 

Laser3Temp Temperature of Laser 3 dec C 

Laser4Current Current to Laser 4 (not used on this 

analyzer) 

mA 

Laser4Tec DAC output to Laser 4 thermoelectric 

cooler 

DN 

Laser4Temp Temperature of Laser 4 dec C 
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MFC1_P_amb - - 

MFC1_T_amb - - 

MFC1_flow - - 

MFC1_flowset - - 

MFC2_P_amb - - 

MFC2_T_amb - - 

MFC2_flow - - 

MFC2_flowset - - 

MPVPosition Integer code for the valve position  - 

OutletValve DAC output to proportional valve at 

cavity outlet 

DN 

ProcessedLoss1 Not used  - 

ProcessedLoss2 Not used  - 

ProcessedLoss3 Not used  - 

ProcessedLoss4 Not used  - 

Ratio1 Ratio of etalon to reference output for 

etalon 1 

Floating point number  

Ratio2 Ratio of etalon to reference output for 

etalon 2 

Floating point number  

Reference1 ADC output from photodiode 

monitoring etalon 1 reference beam 

in WLM 

DN 

Reference2 ADC output from photodiode 

monitoring etalon 2 reference beam 

in WLM 

DN 

SchemeTable Location of this data set in scheme 

used to control data acquisition 

 - 
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Column Description Units (if applicable) 

SchemeVersion Version number for scheme used to 

control data acquisition 

 - 

SpectrumID Integer code identifying the spectrum 

used to generate this line of data 

(=23 for H2O and CH4, 10 for CO2 

Integer 

ValveMask Integer code describing the state of 

the valve sequencer 

 - 

WarmBoxHeatsinkTemp Temperature measured at the warm 

box heatsink 

deg C 

WarmBoxTec DAC output to warm box 

thermoelectric cooler 

DN 

WarmBoxTemp Temperature measured at the warm 

box 

deg C 

base80 -  - 

baseline_level - - 

baseline_slope - - 

cal_enabled Binary flag set to 1 if WLM calibration 

is enabled 

DN 

cavity_pressure Cavity Pressure Torr 

cavity_temperature Cavity Temperature deg C 

ch4_conc_ppm Mole fraction of methane after 

correcting for water cross-talk 

ppm 

ch4_conc_raw Mole fraction of methane from peak 

absorption only, without water 

correction or instrument-specific 

calibration 

ppm 

dm_latency Interval between successive calls to 

the data manager script 

seconds 

fittime Time spent in the fit script for the 

methane spectrum 

seconds 

goodLCT - - 
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Column Description Units (if applicable) 

h2co_adjust - - 

h2co_conc_ppb Mole fraction of formaldehyde after 

correcting for water cross-talk 

ppb 

h2co_conc_raw Mole fraction of formaldehyde from 

peak absorption only, without water 

correction or instrument-specific 

calibration 

ppm 

h2co_shift - - 

h2o_conc_raw Mole fraction of water from peak 

absorption only, without water 

correction or instrument-specific 

calibration 

ppm 

interval - - 

max_fitter_latency Interval between successive calls to 

the fitter script 

seconds 

ngroups - - 

numRDs - - 

peak50 Peak absorption of water line from 

Levenberg-Marquardt fit 

ppb/cm 

peak60 Peak absorption of the methane line 

from Levenberg-Marquardt fit 

ppb/cm 

peak80 Peak absorption of the formaldehyde 

line from Levenberg-Marquardt fit 

ppb/cm 

pzt2_adjust - - 

pzt2_offset - - 

pzt_mean - - 

pzt_per_fsr - - 

pzt_stdev - - 

residuals residual of the fit to the spectrum ppb/cm 

solenoid_valves - - 
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species - - 

spect_duration Time spent acquiring the spectrum seconds 

spect_latency Interval bewteen spectrum 

acquisitions 

seconds 

str50 Coefficient multiplying normalized 

Galatry function for the water line, 

from Levenberg-Marquardt fit 

ppb/cm 

str60 Coefficient multiplying normalized 

Galatry function for the methane line, 

from Levenberg-Marquardt fit 

ppb/cm 

str80 Coefficient multiplying normalized 

Galatry function for the formaldehyde 

line from Levenberg-Marquardt fit 

ppb/cm 

timestamp Unix time stamp for this spectrum  milliseconds 

tiptop - - 

tuner_mean - - 

tuner_stdev - - 

wlm2_offset - - 

y50 Collisional broadening parameter for 

the water line 

dimensionless number 

y60 Collisional broadening parameter for 

the methane line 

dimensionless number 
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